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Drake Tax Manual Supplement: S Corporation What’s New in Drake Tax for S Corporations
S Corporations (1120S)

THE BASICS OF DATA ENTRY FOR AN 
S CORPORATION (1120S) RETURN ARE THE SAME AS 
FOR A 1040 RETURN. NAVIGATION THROUGH DATA 
ENTRY, FIELD- AND SCREEN-LEVEL HELP, AND 
KEYBOARD SHORTCUTS ALL FUNCTION AS THEY DO 
IN THE 1040 PROGRAM. SEE THE 2019 DRAKE TAX 
USER’S MANUAL FOR THE BASICS OF USING THE 
PROGRAM. (THE MANUAL IS AVAILABLE ON THE 
INSTALLATION CD AND ON THE DRAKE SUPPORT 
WEBSITE: SUPPORT.DRAKESOFTWARE.COM > 
TRAINING TOOLS > MANUALS.)

What’s New in Drake Tax for S Corporations

Drake Tax is programmed to conform to the latest IRS rules and regulations. The 2019 
program reflects all changes to forms, credits, and deductions. For details on the new 
regulations for the 2019 tax year, see the IRS instructions for Form 1120S.

The following changes have been made to the 1120S package in Drake Tax for the 
2019 tax season:

New or Enhanced Forms and Screens for 2019

Following are some of the changes the IRS and Drake Tax have made to the S Corpo-
ration package for the 2019 filing season:

• Form 8997, Initial and Annual Statement of Qualified Opportunity Fund (QOF) 
Investments, along with the corresponding data entry screens, has been added to 
the 1120S package in Drake Tax. An investor in a qualified opportunity fund 
(QOF) uses Form 8997 to inform the IRS of the QOF investments and deferred 

IMPORTANT

Some new IRS forms – and the Drake Tax screens 
used to complete these forms – had not been released 
in time for the publication of this supplement.When 
these forms are released, programmed, tested, and 
released, this manual will be updated and available on 
the Drake Support website, Support.DrakeSoft-
ware.com > Training Tools > Manuals.)

Be sure to review the 2019 Drake Tax User’s Manual – 
available from the Support.DrakeSoftware.com website 
– for details on the changes to the tax program and 
practice management tools.
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New or Enhanced Forms and Screens for 2019 Drake Tax Manual Supplement: S Corporation
gains held at the beginning and end of the current tax year, as well as any capital 
gains deferred and invested in a QOF in the current year, and QOF investments 
disposed of during the current tax year. When an investor acquires or sells the 
investment, it must also be reported on Form 8949, Sales and Other Dispositions 
of Capital Assets. See “Form 8997” on page 30 for more information.

• A corporation uses Form 8996 to certify that it is organized to invest in Qualified 
Opportunity Zone (QOZ) property. Screen 8996 is used to complete Parts I, II, 
and IV. This year, Drake Tax added a second screen, Parts V and VI, available 
through a link at the bottom of the 8996 screen. See “QOF Investments” on 
page 30 for more information.

• The IRS added item “J” to page 1 of Form 1120S, with two new check boxes, 
which are completed on screen 1 in Drake Tax:

– Aggregated activities for section 465 at-risk purposes

– Grouped activities for section 469 passive activity purposes

• The IRS made the following changes to Schedule K-1:

– Part III, line 17: codes for Qualified Business Income (QBI) items have been 
changed to a single code “V” 

– Lines 18 and 19 added to Part III of Schedule K-1 to indicate that there are 
attachments to the Schedule K-1 related to the corporation having more than 
one activity for section 465 at-risk purposes, or more than one activity for sec-
tion 469 passive activity purposes, or both.

• Drake Tax is including new worksheets with 1120S returns that include Qualified 
Business Income:

– The “Statement A – QBI Pass-through Entity Reporting” worksheet that 
includes Section 199A items, will be attached to and filed with Schedules K-1 
this year.

– The “Qualified Business Income Information” worksheet – a summary of 
Statement A – will also be generated with the return. This worksheet will not 
be filed and is intended for the entity’s records.

– “Statement B – QBI Pass-through Entity Aggregation Elections,” will be 
attached to and filed with Schedule K-1, and a “Qualified Business Income 
Aggregation” worksheet – a summary of Statement B – will be generated for 
entity’s records.

– “Statement C – QBI Pass-through Entity Reporting,” will be attached to and 
filed with Schedule K-1, for patrons of specified agricultural and horticultural 
cooperatives.

See IRS instructions for more on these statements.

• The MISC screen, added to the Miscellaneous tab of the Data Entry Menu of 
the business packages, includes fields to help preparers keep up with the produc-
tion schedule of a return: Date promised, Date picked up, how much the client 
was charged last year (the 2018 prep fees field), and a check box for indicating 
clients who did not pay their bill last year. This is preparer information only and 
has no affect on the return.

• The Disaster Designation field on the MISC screen is for entering the name of a 
federally designated disaster for those business entities that incurred disaster 
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Drake Tax Manual Supplement: S Corporation Before You Start
losses and that are subject to federal disaster rules. An entry in this field is printed 
across the top of the return but does not otherwise affect the return The field is 
limited to 75 characters (including spaces).

• An option to Update Misc Codes on Screen 1, available during the update pro-
cess (Last Year Data > Update Client 2018 to 2019) was added to the federal 
business packages. For more information on using these code fields, see “Miscel-
laneous Codes” in Chapter 5 of 2019 Drake Tax User’s Manual.

• A Name Control field has been added to the EF screen. Use the Entity Name 
Control Override field only if your client has obtained a Name Control from the 
IRS.” See “Name Control” on page 68 for details.

• An investor in a qualified opportunity fund (QOF) uses Form 8997, Initial and 
Annual Statement of Qualified Opportunity Fund (QOF) Investments, to inform 
the IRS of the QOF investments and deferred gains held at the beginning and end 
of the current tax year, as well as any capital gains deferred and invested in a QOF 
and QOF investments disposed of during the current tax year.

Before You Start

Actions you might need to take before starting an 1120S return in Drake Tax include:

• Updating a prior-year return (if you prepared the return last year)

• Electing as an S corporation (if the corporation was not an S corporation last year)

Updating a Prior-Year Return in Drake Tax

A prior-year return can be updated in three ways:

• As a single return (updated one at a time) using Last Year Data > Update Clients 
2018 to 2019 (recommended) 

• When you open an existing return for the first time in the 2019 program and are 
prompted to update it

• With all other returns in the program at once using Last Year Data > Update Cli-
ents 2018 to 2019 (not recommended)

Indicating an S Corporation

If the corporation is electing as an S corporation for the first time, it is necessary to 
indicate this in the program.

S Corp 
Election

On screen 1 in the General Information section, line A, enter the date of election as 
an S corporation. On line E, enter the date incorporated. On line G, mark the “First 
year as an S corporation” box.

Form 2553, Election by a Small Business Corporation, is required if the entity is mak-
ing the election with the return. In Drake Tax, use screen 2553, accessible by clicking 
the Form 2553 link on screen 1 or from the Miscellaneous tab of the Data Entry 
Menu.
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When you have completed the 2553 screen, open the SH screen – also available from 
the Miscellaneous tab of the Data Entry Menu – and complete a screen for each 
shareholder. Type in the name, address, number of shares, date the shares were 
acquired, and either an SSN or EIN of the shareholder.

Changing 
File Type

To change a “C” corporation to an S corporation (1120 to 1120S) within Drake Tax:

1. From the Home window menu bar, select Tools > File Maintenance > Change 
File Type to open the Convert Client Data File Type search window.

2. In the Client Selection text box, type the EIN or name of the entity. (You can also 
double-click the return from the Client Name list or click the Recent Returns 
drop list and then choose a category to help narrow your search.)

3. Click Continue. 

4. Select the new return type.

5. Click Continue to save the change, then click OK. (Click Exit to leave the Con-
vert Client Data File Type window without making changes.)

Other Information and Overrides

Use screen 1 to enter the following additional information:

• Resident State — If the corporation has a mailing address in one state but does 
business in another, select the state in which the corporation does business from 
the Resident State drop list. (When certain states (DE, IN, KY, MI, MO, NY, OH, 
PA) are selected from the Resident state drop list, the Resident City drop list is 
activated. Select a city to prepare the appropriate city tax return. (If the Resident 
City drop list is inactive, a city return is either not required or not available.)

• Miscellaneous Codes and Overrides — The Other Information section of 
screen 1 includes fields for miscellaneous codes, invoice numbers, and several 
override fields. See “Listing a Different Firm, Preparer, or ERO on a Return” and 
“Customized Drop Lists” in Chapter 2 of the 2019 Drake Tax User’s Manual.

NOTE

• An SH screen must be filled out for each shareholder in order to com-
plete Part I of Form 2553.

• If attaching a signed Form 2553 to the return as a PDF document, mark 
the Attaching Form 2553 as a PDF document box on screen 1. (See 
item M of the FAQs for more on attaching .PDF files to e-filed returns.) If 
not sent as a PDF, the form must be mailed separately to the IRS before 
filing the tax return. See Form 2553 instructions at irs.gov.

NEW FOR 

2019

An option was added to “Update Misc Codes on Screen 1,” available 
during the update process (Last Year Data > Update Client 2018 to 
2019) in the federal business packages. This option allows you to bring 
forward from 2018 the miscellaneous codes and drop lists you created 
last year. For more information on using these code fields, see “Miscel-
laneous Codes” in Chapter 5 of the 2019 Drake Tax User’s Manual. 
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Header Information

Screen 1 contains fields for the general information that is printed in the top section of 
page 1 of Form 1120S.

Name and Address

Use screen 1 to complete the name and address section of Form 1120S. If the corpora-
tion has an alternate address (such as a P.O. box) for state purposes, you can enter that 
address in the Address Line 2 field at the bottom of screen 2. (Access screen 2 by 
clicking the State Info link on screen 1, by clicking 2 from the States tab of the Data 
Entry Menu, or by entering 2 in the selector field and pressing ENTER.)

“Doing
Business 

As”

(Optional) Anything typed into the DBA field in the Name and Address section of 
screen 1 will be printed below the legal name of the corporation in the “Name” section 
of the main form (and on certain other forms, such as Schedule K-1).

Use of the DBA field is optional and data entered there is not required by the IRS. It is 
provided in the program for the return preparer’s convenience.

Continuation 
Line

The DBA field on screen 1 can also serve as a “continuation” line for entity names 
that are too long to fit into the legal name field. Be aware, however, that not all federal 
forms accept data from a continuation (or DBA) line. For those forms, only the data 
entered in the legal name field is used.

“In Care Of” (Optional) Indicate the person or entity to whom all information should be addressed, 
if not to the corporation in general. A name entered in the In care of field on screen 1 
will be printed above the corporation’s name on in the “Name” section at the top of 
page 1 of Form 1120S.

This information is not required by the IRS, but is provided in the program for your 
convenience. It should be used for federal returns and for state returns where applica-
ble.

Do not enter the legal name of the corporation in this field.

Tax Year

The program uses the calendar year as the default period for all corporation returns; no 
date entries are required on screen 1 for a December 31 tax year end.

NOTE Not all states recognize the use of a DBA. Those state packages ignore 
data entered in the DBA field.

NOTES
• The program adjusts calculations for depreciation and for gains and 

losses on sales of assets based on the entity’s tax year.

• For information on filing with a 52-53–week year, see “Electing a 52-
53–Week Year (Initial Return)” on page 67.
Tax Year 2019 13



Header Information Drake Tax Manual Supplement: S Corporation
Fiscal and 
Calendar 

Years

If the S corporation uses a fiscal year (where the year begins in the current calendar 
year and ends in the next), specify the beginning and ending dates in the If not calen-
dar year section of screen 1.

Short-Year 
Returns

A corporation may have to file a short-year return if the entity is changing accounting 
periods with IRS approval (Form 3115), or if this is its first or last year in business and 
the tax year is not a full year.

Short-year return election information and 52-53-week tax year election information 
is entered on the YEAR screen, available from a Year link on screen 1 or on the Mis-
cellaneous tab of the Data Entry Menu. (Certain other elections are made using the 
ELEC screen.)

To enter short-year information:

1. Enter short-year dates on screen 1 in the Fiscal year begins and Fiscal year ends 
fields, even if the firm uses the calendar year for full-year returns. (These dates 
appear on the top of the federal form.)

2. Click the Year link to open the YEAR screen.

3. Make your short-year selection from the Other short-year election reason drop 
list. Your explanation appear at the top of the first page of the tax return. If you do 
not select an explanation, an EF Message is generated with the return and the 
return cannot be e-filed

4. If you selected “General Explanation” from the Other short-year reason drop 
list, type details of the reasons for filing a short-year return in the Explanation 
text box.

First-Year 
Returns

An S corporation filing a first-year return must use the fiscal-year fields in the If not 
calendar year section of screen 1 if the date of election as an S corporation occurs 
after the start of the tax year—that is, if the date entered on line A of the General 
Information section of screen 1 comes after January 1, 2019.

In the Fiscal year begins field, enter the date of election as an S corporation. In the 
Fiscal year ends field, enter the end of the calendar year (or the end of the fiscal year 
if not using a calendar year).

Boxes A through J

Enter most information for boxes A through J (top of Form 1120S) on screen 1. Note 
that boxes C (“M-3 attached”) and F (“Total assets”) are completed automatically by 
the program based on data entered elsewhere. Other boxes are:

• Box A — S election effective date

NOTES
For more information on short-year explanations, see IRS Pub. 4163.

The program may not correctly calculate depreciation, gains, or losses 
for a short-year return. Depreciation for a short-year return can be 
entered on screen 4562 and screens 6, 7, 8, and 9.
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• Box B — Business activity code (From screen 1, choose a code from the line B 
drop list, or click in the line B field and press CTRL+SHIFT+S to search for a 
code.)

• Box D — Employer Identification Number (EIN)

• Box E — Date incorporated

• Item G — Indicates first year as S corporation and inclusion of Form 2553 with 
return

• Item H — Check boxes for final return, name change, address change, amended 
return, and S election termination or revocation

• Item I — Number of shareholders during the year (completed automatically based 
on the number of K-1s; number can be overridden on line I of screen 1.)

• Item J — (New for 2019) Mark the Aggregated activities for section 465 at-risk 
purposes check box if any activities covered by the at-risk rules can be treated as 
a single activity. Mark the Grouped activities for section 469 passive activity 
purposes check box if any activities covered by the grouping passive activities 
can be treated as a single activity. (For more information, click in the box and 
press F1.)

QBI Section Screen 1 in Drake Tax now has three boxes in the QBI section. Mark them accord-
ingly:

• Mark the Specified Trade or Business check box if the corporation is a specified 
trade or business.

• Individuals, estates, and trusts that are shareholders in an S corporation may be 
entitled to a deduction of up to 20 percent of their Qualified Business Income 
(QBI) from a trade or business, plus 20 percent of qualified Real Estate Invest-
ment Trust (REIT) dividends and qualified Publicly Traded Partnership (PTP) 
income. If the shareholders are claiming the Qualified Business Income deduction 
and choose to aggregate (combine) businesses for purposes of computing the QBI 
deduction, type a unique number in the Potential Business Aggregation Number 
(PBAN) box. Use this same number on the screen for each business that poten-
tially could be aggregated. To create more than one aggregation group, use a dif-
ferent PBAN for each separate group.

• Type a number in the Business Aggregation Number (BAN) check box if the 
corporation entity elects to aggregate (combine) businesses for purposes of com-
puting the Qualified Business Income deduction. Type the same number in this 
field as you put in the BAN field each business that is to be in the aggregation. (If 
there will be more than one aggregated group, put in the BAN field on screen 1 
the number of the group the main entity will be aggregated with.)

For more information on these fields, turn to “Passing Through QBI Information” on 
page 35, “Denoting Service Trades or Businesses” on page 36, and “Aggregation, 
BANs, and PBANs” on page 39 of this document, or click in the box and press F1.) 

NOTES
Enter the accounting method on screen 1.

The Client information fields near the bottom of screen 1 are for 
reports only and not included in the e-file record.
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Income and Deductions

Income and deductions are entered primarily on the INC (Income) and DED (Deduc-
tions) screens.

Gross Receipts

Enter gross receipts or sales (line 1a of Form 1120S) and returns and allowances (line 
1b) on the INC screen. The program calculates gross receipts or sales after returns and 
allowances based on gross receipts, sales, and any direct entry on line 1b.

Cost of Goods Sold (Form 1125-A)

For cost of goods sold (COGS), complete screen A (Form 1125-A, Cost of Goods 
Sold).

Inventory Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Sched-
ule L, line 3 (“Inventories”). Note that the Inventories fields on screen L (Assets, 
Liabilities and Equity) are overrides. Anything entered there overrides the inventory 
data that flows from screen A.

Line 5, Other 
Costs

Line 5 of Form 1125-A is designated for any applicable costs not entered on the previ-
ous lines. In Drake Tax, two fields on screen A are provided for line 5: one for other 
costs excluding depreciation, and one for depreciation (see figure below).

In the field on the Depreciation line, enter any depreciation that relates to the cost of 
goods sold (unless the amount is flowing from the 4562 Detail screen with COGS 
selected from the For drop list).

Note that the Depreciation field 
on screen A is an override field; an 
entry here overrides the calcula-
tions from the 4562 screen. 
Amounts entered in this field auto-
matically adjust the total deprecia-
tion flowing to page 1 of Form 
1120S.

NOTE
The IRS does not require a detail (CTRL+W) worksheet for gross 
receipts; therefore, if you are using the trial balance import feature, do 
not include a detail worksheet for this line—or for any line that does 
not require a detail worksheet. For more on the trial balance work-
sheet, see “Importing Trial Balance Information” on page 74.

NOTE For information on completing lines 9a through 9f of screen A, click in 
a field and press F1 or consult the IRS instructions.
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Entries in the Other costs - excluding depreciation field opens a Detail Worksheet.

Importing 
Trial Balance 

to Form 
1125-A

If using the trial balance import feature (see “Importing Trial Balance Information” on 
page 74), enter depreciation amounts directly into the appropriate fields on the trial 
balance worksheet, not into the “depreciation” fields in data entry. When the trial bal-
ance is imported, the COGS depreciation expense amount flows directly to the appro-
priate line of Form 1125-A and is calculated accordingly.

Ordinary Gains and Losses

The amount on line 4 (“Net gain (loss) from Form 4797, Part II, line 17”) of Form 
1120S flows from Form 4797, Gains and Losses from Sales of Assets. Amounts can 
also flow from screen 4562, but only if that screen shows assets sold and property 
type. Screen 4797 is available from the Assets-Sales-Recapture tab of the Data 
Entry Menu.

Other Income (Loss)

Enter all amounts for line 5 of Form 1120S, “Other income (loss),” on the INC screen. 
INC screen data is displayed on attached statements in View/Print mode.

Adjustments are made to the appropriate deduction/expenses for the credit amounts 
for the following credits:

• Form 5884, Work Opportunity Credit

• Form 6765, Credit for Increasing Research Activities

• Form 8820, Orphan Drug Credit

• Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Cer-
tain Employee Tips

• Form 8881, Credit for Small Employer Pension Plan Startup Costs

• Form 8912, Credit to Holders of Tax Credit Bonds

• Form 8941, Credit for Small Employer Health Insurance Premiums

Additional fields on the INC screen include:

• Amount of credit for tax on fuels

• Interest income on receivables

• Recoveries of bad debts

• Section 481 adjustments

• State tax refund

• Income from insurance proceeds

NOTE
Line 14b on the DED screen, “Depreciation claimed elsewhere on 
return,” is for Form 4562 depreciation included on screen A and else-
where on the return. This is an adjustment field. No entry is required in 
this field as the program makes the adjustment for depreciation claimed 
elsewhere on the return automatically.
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To enter income or loss from a partnership, estate, or trust, use screen K1P or K1F. 
(Click the screen links on the INC screen or access them from the Other Forms tab). 

To enter additional sources of income not shown, use the Other Income (itemize) 
field on the INC screen. (An entry in this field creates a Detail Worksheet.)

Extender Tax credits revived

Certain “extender” tax credits have been revived for 2019. In fact, these extenders are 
retroactive, so taxpayers who were unable to claim these credits in 2018 are now eligi-
ble for to file amended returns.

Compensation and Wages

Enter shareholder compensation and employee wages on the DED screen. Drake Tax 
has two fields each for officer compensation and employee salaries/wages: one for 
non-shareholders, and one for shareholders.

Credit 
Adjustments

A credit adjustment is made for the following forms:

• Form 5884, Work Opportunity Credit

• Form 8844, Empowerment Zone and Renewal Community Employment Credit

• Form 8845, Indian Employment Credit

• 8994, Employer Credit for Paid Family and Medical Leave

• 8932, Credit for Employer Differential Wage Payment

The adjustment is indicated on Form 1120S with the “Wks Sal/Wage” literal 
(Figure 1). Actual adjustments are shown on the “Wks Sal/Wage” worksheet in View/
Print mode.

Figure 1: ATT_SSW literal on Form 1120S

NOTES

The Salaries and wages to non-shareholders field is an adjust-
ment field. An amount entered here is combined with any amount 
entered in the Labor hired field on screen F.

The Officer compensation – shareholders and Officer compen-
sation – non-shareholders fields are override fields. Entries in 
these fields override entries on screens E and K1.
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Compensation of Officers (Form 1125-E)

Enter officer information (name, address, ownership percentage, compensation) for 
officers who are shareholders on the K1 screens as you are entering shareholders’ 
information. Use screen E to enter officer information and compensation amounts for 
officers who are not shareholders.

For details on entering officer information on screen K1, see “Officer and Shareholder 
Data Entry” on page 42.

Officer 
Information

Use screen E to enter officer information and compensation amounts for officers who 
are not shareholders. Press PAGE DOWN to enter additional officers. Screen E totals 
are calculated and carried to line 7 of Form 1120S.

The total of officer compensation (shareholders and non-shareholders) can be entered 
in the Officer Compensation override fields of the DED screen (generally used when 
Form 1125-E is not required). An entry in those fields override any calculations from 
screen E of the 1120S but does not change the calculations on Form 1125-E.

Screen E 
Check Boxes

Screen E has two check boxes: Signs return and Books in care of. Mark the applica-
ble box on the screen that identifies the officer who signs the federal or state returns, 
and the officer who is the contact person for the books.

Ownership 
and 

Participation

The Ownership and Participation fields on either screen K1 or screen E are 
required. (See NOTE, following.)

Fields are as follows:

• Total — Enter the officer’s ownership percentage.

• Common — Enter the percentage of common stock owned by the officer.

• Preferred — Enter the percentage of preferred stock owned by the officer.

• Time — Enter the percentage of time the officer devotes to the corporation.

Enter percentage amounts in whole numbers. For example, enter 40 for 40%.

NOTES

For privacy and security, you can “truncate” (hide certain digits of) 
SSNs on Form 1125-E by entering only the last four digits of the offi-
cers’ SSNs in the ID number field.

To do so, enter the first five digits of the SSN as “0”s (zeros), and then 
enter the final four digits of the SSN. Press CTRL+F to “force” the pro-
gram to accept the number.

For example, enter SSN 123-45-6789 as 000-00-6789. Press 
CTRL+F.

NOTE
If you mark the Signs return check on box screen E, that officer’s infor-
mation flows to the PIN screen automatically, eliminating the need to re-
enter that information. You would still have to enter PINs for the ERO 
and the officer and signature date on the PIN screen for e-file purposes.
Tax Year 2019 19



Income and Deductions Drake Tax Manual Supplement: S Corporation
Repairs and Maintenance

Enter repair and maintenance costs on the DED screen. An amount entered there is 
combined with the amount, if any, entered in the Repairs and maintenance field on 
screen F.

Bad Debts

Use the Bad debts field on the DED screen to enter the total debts that became worth-
less in whole or in part during the year, but only to the extent that such debts related to 
a trade or business activity.

Rents

Use the DED screen to enter rent paid on business property used for a trade or busi-
ness activity. If the corporation rented or leased a vehicle, enter the total annual rent or 
lease expense incurred in the trade or business activity of the entity, and then complete 
Part V of the 4562 (screens 8 and 9). 

Taxes and Licenses

Enter tax and license amounts on the Taxes and License screen (accessed by clicking 
the Detail link on the DED screen). Amounts are combined and the sum generated on 
worksheet “Wks Tax/Lic” (available in View/Print mode) and flow to Form 1120S, 
line 12 (“Taxes and licenses”). Note that credit from Form 8846 (Credit for Employer 
Social Security and Medicare Taxes Paid on Certain Employee Tips) should be 
entered on screen 8846, which is accessible via the Detail link on the DED screen or 
from the Credits tab of the Data Entry Menu. These amounts also appear on the 
“Wks Tax/Lic” statement in View/Print mode and is referred to on line 12 with the lit-
eral “Wks Tax/Lic” reference (see circle in figure on the next page).

NOTE If using screen E for non-shareholding officers, enter 0 in the Common 
and Preferred fields.

NOTES
Enter deductible nonbusiness bad debts as a short-term capital 
loss on screen 8949 (Sales and Other Disposition of Assets).

Cash-method S corporations cannot take a bad debt as a deduc-
tion unless the amount was previously included in income.

NOTE
The Rents field is an adjustment field. An amount entered here is 
combined with the amount, if any, entered in the Rent fields on 
screen F.
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To keep the 
notification 
from appearing 
on line 12 of the 
return, go to the 
PRNT screen 
and select Sup-
press printing 
of form and 
attachment 
references.

The fields on 
the line for State/City Income taxes and St/City franchise taxes on the Detail screen 
are override fields. Amounts entered in these fields override amounts calculated from 
entries on the ES screen and flow to the “Wks Tax/Lic” worksheet.

State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes) 
screen flow to the “Wks Tax/Lic” worksheet. The state tax amount flowing from the 
ES screen may differ depending on which method of accounting (cash or accrual) is 
used. 

Interest

Using the 1120S instruction guidelines, enter interest expense on the DED screen. 
Note that the Interest expense field is an adjustment field. Any amount entered here 
is combined with the amount, if any, entered in the Interest fields on screen F.

See the field-level help (click in the Interest expense field and press F1) for more 
information.

Depreciation

Enter depreciation on the 4562 screen. Make a selection from the For drop list to asso-
ciate the depreciable item with the correct form or activity. Data from the 4562 screens 
is calculated and it then flows to Form 1120S and to the selected schedules or forms.

For more information on depreciation and the 4562 screen in Drake Tax, see the 2019 
Drake Tax User’s Manual.

Line 14, 
Depreciation

Line 14 of Form 1120S is reserved for depreciation that (1) is from Form 4562, and 
(2) is claimed on Form 1125-A or elsewhere. While data from the 4562 screen flows 
to this line, the program also provides field 14b on the DED screen specifically for 
depreciation that is claimed elsewhere.

Both lines 14a and 14b on the DED screen are adjustment fields.

• Line 14a — See field-level help for further instructions and information on 
how this field ties in to Form 4562.

• Line 14b — Drake Tax recommends entering depreciation on the 4562 
screen, and then selecting COGS from the For drop list at the top of that 
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screen. You can also use screen A (rather than the DED screen) to enter depre-
ciation claimed on Form 1125-A. An entry on screen A adjusts any entry on 
line 14b of the DED screen and is calculated into the total deductions for page 
1 of Form 1120S. If there is an entry on line 14b of the DED screen but not on 
screen A, only the line 14b amount is calculated into total deductions.

Depletion

Enter depletion amounts on the DED screen. If the corporation claims a deduction for 
timber depletion, complete and attach Form T, Forest Activities Schedules. (Attach as 
a PDF file to e-filed returns. See “The PDF Attachment Process” on page 71.) Do not 
deduct depletion for oil and gas properties. (Each shareholder should figure depletion 
on these properties under section 613A(c) (11).)

Advertising

Enter advertising expenses on the DED screen.

Pension and Profit-Sharing

Enter pension and profit-sharing expenses on the DED screen. Click inside the field 
for line 17 and press F1 for information on what expenses to enter. The program 
reduces the expense based on the credit amount calculated from Form 8881, Credit for 
Small Employer Pension Plan Startup Costs. Note that the field for line 17 is an 
adjustment field. An amount entered here adjusts the amount flowing to Form 1120S 
from Schedule F, line 23.

Employee Benefits Program

Enter on line 18 of screen DED the total for fringe benefits paid or incurred on behalf 
of employees owning 2% or less of the corporation’s stock. Do not include with these 
amounts anything that is an incidental part of a pension, profit-sharing, etc., plan or 
amounts reported elsewhere on the return.

Report amounts paid on behalf of more than 2% shareholders on line 7 (“Officer com-
pensation”) or 8 (“Salaries and wages”) of the DED screen. A shareholder is consid-
ered to own more than 2% of the corporation’s stock if that person owns, on any day 
during the tax year, more than 2% of the outstanding stock of the corporation or stock 
possessing more than 2% of the combined voting power of all stock of the corpora-
tion.

Note that the field for line 18 is an adjustment field. An amount entered in here adjusts 
the amount flowing to Form 1120S from Schedule F, line 15.

NOTES
• Form T, Forest Activities Schedules, is not available in Drake Tax. 

Visit its.gov to download the form.

• For oil and gas depletion, see “Oil and Gas Depletion Worksheet” on 
page 41.
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Other Deductions

Enter all other deductions in the “Other deductions (itemize)” field on the DED 
screen. Drake Tax incorporates the total into line 19, “Other deductions,” on Form 
1120S.

The following deductions, credits, adjustments, and exclusions also flow to line 19:

• Amortization from Form 4562

• Credit adjustment from Form 8820, Orphan Drug Credit

• Exclusion from Form 8873, Extraterritorial Income Exclusion

• Credit from Form 8941, Credit for Small Employer Health Insurance Premiums

• Credit from Form 6765, Credit for Increased Research Activities

• “Amortization” from screen K1F, line 9, code “C” 

• “Other expenses” from screen F, line 32 

Tax and Payments

Screen 4 has fields for completing the “Tax and Payments” section of Form 1120S. 
Note that some fields are overrides fields. Press F1 to view more information on a 
field.

Net Passive Income

Line 22a, “Excess net passive income or LIFO recapture tax,” could apply to an S cor-
poration if it was formerly a “C” corporation or if it engaged in a tax-free reorganiza-
tion with a “C” corporation.

To determine if the corporation must pay the tax, complete the worksheet fields on the 
lower half of screen 4. If completing the IRS worksheet, enter the worksheet results on 
screen 4. Enter LIFO recapture directly on screen 4.

Schedule D

Use screen 8949 (available from the Asset-Sales-Recapture tab of the Data Entry 
Menu) to enter capital gains and losses. The net gain from screen 8949 is carried to 
line 10, “Other income” of Schedule K (unless a “Property type” is selected on screen 
8949, then the net gain flows to lines 7 and 8 of Schedule K). Use screen 8949 to enter 
data for Parts I and II of Schedule D (Form 1120S), Capital Gains and Losses and 
Built-in Gains. Use the D2 screen for Part III, “Built-in Gains,” of Schedule D (Form 
1120S). For information on using screen 8949 and the 8949 import feature in Drake 
Tax, see “Capital Asset Reporting” and “Form 8949 Imports” in Chapter 5 of the 2019 
Drake Tax User’s Manual.

NOTE To force the line 22a worksheet to be printed, select the applicable 
box on screen 4.
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Put in the total from a brokerage statement (Form 1099-B) for short-term transactions 
for which basis was reported and for which there are no adjustments on line 1a of 
screen D2; long-term transactions are entered on line 8a.

Estimated Taxes

Form 1120S does not have a federal estimated tax voucher. Estimated tax payments 
are required only in certain situations. An S corporation must make electronic deposits 
of employment, excise, and corporation income taxes using the Electronic Federal Tax 
Payments System (EFTPS).

ES Screen The ES screen (available from the Miscellaneous tab or from the ES Screen link on 
screen 4) provides a place to enter federal and state estimated taxes paid in 2019. If the 
return was updated in Drake Tax from 2018, this information flows from the 2018 
return. Note that this information is overridden by any entry in the Current-year esti-
mated tax payments field on screen 4.

Use the ES screen for 2020 estimated payments. Future-year amounts appear on the 
“Estimate Summary” worksheet, generated with the return. (You must enter amounts 
in the “voucher” fields in the Estimate amt column to generate the Estimate Sum-
mary worksheet.) To enter the amount to be credited, use the Amount of overpay-
ment to apply to 2020 field. Note that this information is overridden by any entry in 
the Amount to be credited to next year’s estimated tax field on screen 4.

The ES screen also provides a way to e-file state estimated tax vouchers and pay-
ments, which is required in some states. For estimated taxes from multiple states or 
cities, press PAGE DOWN and go to a new ES screen.

For details on using the ES screen for filing federal estimated taxes and paying state 
estimated taxes, see “Estimated Taxes” in Chapter 5 of the 2019 Drake Tax User’s 
Manual.

Payments with Extensions

To make a payment with an extension request, enter the amount being paid in the 
“Amount paid with extension” field at the bottom of the 7004 screen (available from 
the Other Forms tab or from a link on screen 4). If an extension was previously 
requested and a payment was made then, enter the amount paid on screen 4, line 23b.

For electronic payments on extensions, the program produces Form 8878-A, the IRS 
e-file Signature Authorization for Form 7004. See “Filing an Extension” on page 27.

Tax Paid on Fuels

Use screen 4136 (available from the Credits tab of the Data Entry Menu) to enter 
information for Form 4136, Credit for Federal Tax Paid on Fuels. Note that this form 

NOTE
Most states do not allow estimate payments outside of the EFTPS 
system. View the field help for the e-file check box in the e-file/Elec-
tronic Fund Withdrawal section of screen ES for a list of states that 
allow e-filed payments.
24 Tax Year 2019



Drake Tax Manual Supplement: S Corporation Direct Deposit of Refunds
consists of four pages – pages 1 and 2 (lines 1 through 8f) on the first screen in Drake 
Tax. Press PAGE DOWN to reach pages 3 and 4 (lines 9 through 16b). Press PAGE UP or 
PAGE DOWN to toggle back and forth between the screens.

Underpayment of Estimated Tax

For underpayment of estimated tax, complete all applicable fields on screen 2220. 
(Note that this screen, available from the Other Forms tab of the Data Entry Menu, 
also consists of two screens.)

Late-Filing Penalty

Drake Tax does not calculate a late-filing penalty. You can choose to enter a late-filing 
penalty on screen 4, line 24, “Estimated tax penalty.”

Direct Deposit of Refunds

The IRS requires that Form 8050, Direct Deposit of Corporate Tax Refund, be submit-
ted with an e-filed return in order for a corporation’s refund to be directly deposited. 
To complete this form in Drake Tax, use the DD screen (available from the General 
tab of the Data Entry Menu).

Figure 2: Federal section of DD screen (also 8050 screen)

When filling out screen DD (Figure 2):

• If the federal refund is to go to the account listed, select Yes for the Federal 
Account selection; otherwise, select No. (If neither is selected, the program uses 
the default selection – Yes.)

• If a state refund is to go to the account listed, select the state abbreviation from the 
State/city selection drop list.

NOTE
The program produces the Worksheet for the Underpayment of Esti-
mated Tax by Corporations (“Form 2220 - Calculations” worksheet in 
View/Print mode) to explain the calculations for the 2220 penalty. 

IMPORTANT
If you enter a late-filing penalty on screen 4, line 24, then 
Form 2220, Underpayment of Estimated Tax, will not be 
included in the e-file transmission.
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• Enter the name of the financial institution, the routing number (RTN), the account 
number, and the type of account (Checking or Savings). (For validation of 
entries, the RTN, account number, and type of account must be entered twice.)

If receiving refunds from more than one state tax authority, use the State Account sec-
tions on the DD screen to indicate where other state refunds should be deposited.

International ACH Transactions

State taxing agencies have added foreign account questions to their forms to comply 
with NACHA rules regarding International ACH transactions (IAT); however, pro-
cessing IAT is not yet supported by any federal or state tax authority. If you were to 
indicate that the account was outside the U.S., the state tax authority would automati-
cally ignore the account information and either issue a paper-check refund, or contact 
the corporation requesting the payment of a balance due via check or domestic bank 
account. If you indicate that an account is located outside of the U.S., Drake Tax gen-
erates an EF Message instructing you to choose an account located in the U.S.

For more information, see Screen Help on the DD screen and PMT screen.

Electronic Funds Withdrawal (Direct Debit)

Use the PMT screen, accessible from the General tab, to indicate that the balance due 
for an e-filed return should be withdrawn (direct-debited) from an account.

Program Defaults and Overrides

By default, the program indicates that the entire balance due (the “Amount owed” line 
of Form 1120S) is to be withdrawn on the return due date. To indicate otherwise, com-
plete the “Requested payment amount” and the “Requested payment date” override 
fields of the PMT screen for the applicable payment.

If the return is e-filed on or before the due date, the requested payment date cannot be 
later than the due date. If the return is transmitted after the due date, the requested pay-
ment date cannot be later than the current date.

Required Information

A Withdrawal selection (item #1 in Figure 3 on page 27) is required if the program is 
to direct federal and state tax authorities to withdraw funds from the taxpayer’s 
account.
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Figure 3: Required fields on PMT screen: withdrawal selection (1);
account information (2); specified return (3)

The name of the financial institution, routing number (RTN), account number, and 
account type are required. As is the case with the DD screen, the RTN, Account num-
ber, and Type of account data must be entered twice (item #2 in Figure 3).

Finally, the PMT screen must indicate the return to which the payment data applies 
(item #3 in Figure 3). Put a check mark in the box of the applicable return type.

Withdrawal from Multiple Accounts

Only one account can be designated for direct debit of funds for payment of federal 
taxes or state taxes. To have state amounts withdrawn from an account other than the 
account indicated for federal payments, complete the fields in the State Account sec-
tions of the PMT screen. 

Filing an Extension

Calendar year returns are due on March 15, 2020. By filing Form 7004, an S corpora-
tion can extend the deadline six months to September 15. Fiscal year returns are due 
on the 15th day of the third month after the end of their tax year. Form 7004 extends 
the deadline six months.

For electronic payments with extensions, the program produces Form 8878-A, the IRS 
e-file Electronic Funds Withdrawal Authorization for Form 7004.

To file an 1120S extension, use either of the following options:

• Go to the 7004 screen in Drake Tax (available from the Other Forms tab of the 
Data Entry Menu) and select Generate an extension. Complete any other appli-
cable fields on the screen.

NOTE Neither the federal nor the state balance due can be paid from more 
than one account.
Tax Year 2019 27



Signing the Return Drake Tax Manual Supplement: S Corporation

 

 

• Go to the PRNT screen (available from either the General or Miscellaneous 
tabs) and select Prepare Form 7004 based on screen 1 data.

Signing the Return

Electronic PIN signatures are required to e-file returns. All fields on the PIN screen 
must be completed to e-file a return, including the title and signature (name) of the 
officer signing the return.)

An 1120S return must be signed and dated by one of the following individuals:

• The corporation’s president, vice president, treasurer, assistant treasurer, or chief 
accounting officer

• Any other corporation officer, such as a tax officer, who is authorized to sign

If the return is prepared by a paid preparer, the preparer must complete the required 
information on the PIN screen. If it is prepared by an employee or officer of the cor-
poration, open screen 1 and select NONE in the Firm # and Preparer # fields.

To have the preparer’s name and address information displayed on the printed return:

• If the return preparer and ERO (entered in Setup > ERO) are the same:

– Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signa-
ture box is marked for the preparer.

– Complete the PIN screen for the return.

• If the return preparer and ERO are not the same:

– Go to the PRNT screen for the return and complete the field labeled PIN for 
preparer’s alternative electronic signature. The PIN entered should match 
the one entered for the preparer in Setup > Preparer(s). (For more informa-
tion, press F1 in this field.)

NOTE
If you mark the Signs return check box either screen K1 or screen E, 
that officer’s information flows to the PIN screen automatically, eliminating
the need to re-enter that information. You would still have to enter PINs 
for the ERO and the officer and signature date on the PIN screen for e-file
purposes.

NOTE
Setup > ERO & Account Information must be completed for e-file. 
For information on how to complete this setup window, see 2019 Drake 
Tax User’s Manual. See the IRS instructions for further details on signa-
ture requirements.
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Amending a Return

Amended 1120S can be e-filed using Drake Tax.

To file an amended 1120S return:

1. Go to screen 1 and select Amended return in section H.

2. Make changes as applicable to forms and schedules.

3. Go to the EF screen and mark the Amended 1120S check box on the left side of 
the screen.

Type AMD or X 
into the selector 
field and press 
ENTER.

4. Go to screen X (available from the Miscellaneous tab of the Data Entry Menu) 
and, using a fresh X screen for each line changed in the 1120S, describe and 
explain the changes. Press PAGE DOWN to open a new X screen.

If amending just the Schedules K-1, go to each applicable K1 screen, select Amended 
K1, and make needed changes.

Additional Information

This section covers Schedule B (Other Information), state-specific information, and 
some program overrides.

Schedule B

Enter the accounting method, principal business activity, and product or service on 
screen 1. This information flows to lines 1 and 2 of Schedule B.

Use screen B (accessible from the General tab of the Data Entry Menu) to answer 
questions 3 through 15 of Schedule B.

Select B1 from the 
Data Entry Menu 
or enter B1 in the 
selector field and 
press ENTER.

If the answer to question 3 on screen B is “Yes,” complete screen B1 (press PAGE 
DOWN from screen B). If the S corporation owned, directly, 20% or more, or owned, 
directly or indirectly, 50% or more of the total stock issued and outstanding of any for-
eign or domestic corporation, click the B4A Screen link on screen B to enter informa-
tion about the domestic or foreign corporation owned. (You can enter information for 
up to 10 corporations per B4A screen; to add more, press CTRL+PAGE DOWN.)

If the S corporation owned, directly, 20% or more, or owned, directly or indirectly, 
50% or more in the profit, loss, or capital in any foreign or domestic partnership 

CAUTION

When you amend a return in Drake Tax, the amended informa-
tion replaces the original in the data file. Before amending a 
return, you should archive the original to avoid losing previ-
ously submitted data. For more information on archiving 
returns, see “Archive Manager” in Chapter 6 of the 2019 Drake 
Tax User’s Manual.

NOTE
All K-1s are amended when an 1120S return is amended, and the 
“Amended K-1” box on all Schedules K-1 is marked by default. To 
override this default, go to the PRNT screen and mark Do NOT 
check amended box on Sch. K-1.
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(including an entity treated as a partnership), or in the beneficial interest in a trust, 
click the B4B Screen link on screen B to enter information about the domestic part-
nership owned. (You can enter information for up to 10 partnerships per B4B screen; 
to add more, press CTRL+PAGE DOWN.)

Business Interest Expense Limitations

For tax years beginning in 2018, every taxpayer who deducts business interest is 
required to file Form 8990, Limitation on Business Interest Expense Under Section 
163(j), unless an exception for filing is met. Click the 8990 link on the Other Forms 
tab of the Data Entry Menu.

Before entering data in the fields on screen 8990, enter data all other screens needed to 
complete Form 1120S. View the return (press CTRL+V) and note the “Income (loss) 
reconciliation” on page 4, line 18, of Form 1120S, then return to this screen and enter 
the taxable amount on line 6. Complete all other appropriate fields on this screen.

QOF Investments 

There are special rules for eligible gains invested in Qualified Opportunity Funds.

Form 8996 A corporation files Form 8996, Qualified Opportunity Fund, annually to report that 
the QOF meets the 90% investment standard of section 1400Z-2 or to figure the pen-
alty if it fails to meet the investment standard

In Drake Tax, screen 8996 has been added for completing Form 8996. Screen 8996 is 
available from the Other Forms tab of the Data Entry Menu or through a link on 
line 15 of screen B.

Part I certifies that the corporation was organized to operate as a QOF. Part II deter-
mines whether the corporation meets the 90% investment standard for a QOF. Entries 
in Part IV calculate any penalties for each month that the QOF did not hold at least 
90% of its assets in QOZ property.

Complete Parts I, II, IV on screen 8996. Click the link at the bottom of the screen to 
complete Parts V and VI.

QOZ Tract 
Numbers

(New for 2019) On the Parts V and VI screen, select the form part to which data 
entered in this screen should flow. In the QOZ Tract No. column, enter the designated 
11-digit census tract number. (To find this tract number, go to irs.gov/pub/irs-drop/n-
18-48.pdf for a list of Designated Qualified Opportunity Zones, listed by state and 
county. 

See Form 8996 and its related instructions for more information.

Form 8997 An investor in a qualified opportunity fund (QOF) uses Form 8997, Initial and Annual 
Statement of Qualified Opportunity Fund (QOF) Investments, to inform the IRS of the 
QOF investments and deferred gains held at the beginning and end of the current tax 
year, as well as any capital gains deferred and invested in a QOF and QOF invest-
ments disposed of during the current tax year.
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State-Specific Information

Resident 
State

The program automatically generates a return for the corporation’s resident state. Use 
screen 2 to enter company information as it should appear on the state return.

Company Information on screen 2 includes the type of return that applies for state 
purposes (consolidated, composite, controlled group, multi-state) and state-specific 
dates, numbers for identification, and fields for miscellaneous data as may be required 
by a state.

Contact 
Information

If certain contact information required for state purposes is different from that entered 
on screen 1, use screen 2 for the alternative data for any of the following entities:

• Registered office

• Principal place of business

• “Books in care of” information

Screen 2 also has fields for the name, title, mailing address, email address, ID number, 
and telephone number of the S corporation’s contact person.

Other States Data for other states must be entered manually in state data entry. To access state data 
entry, select the States tab from the Data Entry Menu and choose a state, or enter the 
two-letter state code in the selector field and press ENTER.

Multi-State 
Appor-

tionment

Enter sales, payroll, and property factors on the APPT Multi-State Apportionment 
screen (Figure 4 on page 32). This screen provides one central location for entering all 
state apportionment information instead of having to open each needed state’s screen. 

In addition to making data entry faster and easier, this feature provides two work-
sheets: a summary worksheet (“Wks SA-SUM”) that can be used for verifying input, 
and a reconciliation worksheet (“Wks SA-REC”) that ties the total of the state 
amounts to the federal return figures. These worksheets are available in View/Print 
mode.

The individual state apportionment screens will continue to be available next year in 
Drake ’19, but will be used to override data entered on the APPT screen. No state 
apportionment-related screens will be updated from 2018 to Drake ’18.

NOTES
The Company Information fields on screen 2 apply for the resi-
dent state only.

Click the screen 2 link from the States tab or enter 2 in the selector 
field and press ENTER to open screen 2.
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Figure 4: APPT Multi-State Apportionment screens

APPT 
Screens

The APPT screen is opened to the Sales tab. Links at the top of this screen take you to
the Payroll, Property, and Additional Property tabs for each state selected 
(Figure 4). These screens and their uses are listed in Table 1:

You may enter up to four states on one APPT screen. If you need more than four 
states, press PAGE DOWN for a new APPT screen. The same state can be entered more 
than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list when using the 
reconciliation worksheet. Not every item appearing on the federal return may be sub-

NOTE
Mark the Zero Apportionment check box (Figure 4) to add a state 
but not include any apportionment data. This will include the state 
on the apportionment summary worksheet (“Wks SA-SUM”), avail-
able through View/Print mode.

Table 1: APPT Screens

Screen Information

Sales Select state; enter sales, returns and allowance, and other 
income-related information for each selected state

Payroll Enter salary, wage, commission, and labor amounts for 
each selected state

Property Enter beginning and ending amounts of common apportion-
ment factors; select additional apportionment factors from 
drop lists

Additional Property Select additional apportionment factors from drop lists

NOTE
The Ending amount entered on the Property and Addition Property 
screens in Drake ’18 will become the Beginning amount for property 
on the APPT screen when the client’s return is updated next year in 
Drake ’19.
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ject to multi-state apportionment. When you select OT, the data entered becomes a 
reconciling adjustment amount to aid in tying to the federal return. 

Enter as much or as little detail as the states require. If a state does not require any 
information to be entered, no information flows to that state’s return.

Schedule K: Shareholders’ Pro Rata Share Items

Screen K, which consists of five “tabbed” screens, can be used to enter data for 
Schedule K, Shareholders’ Pro Rata Share Items. Note that many K fields are adjust-
ment fields. Press F1 inside a field to see what amounts are adjusted from elsewhere in 
the program.

Navigation

Screen K has separate tabs for data entry of Income, Deductions, Credits, AMT and 
Basis, and Other Information (item #1 in Figure 5). Click the tabs at the top of the K 
screen or press PAGE UP and PAGE DOWN to navigate among the K screens.

Figure 5: Screen K is a tabbed screen (item #1)

Each of the tabs includes “Other” items, such as “Other” income, “Other” deductions, 
“Other” credits (see item #2 in Figure 5), allowing a detailed supplemental K-1 state-
ment (Figure 6 on page 34).
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Figure 6: More detailed K-1 statements with Schedule K “Other” items

Information on foreign transactions is entered on a separate KFT screen, accessible 
from the Foreign tab of the Data Entry Menu or from the Schedule K Foreign 
Transactions link on the Credits tab of screen K. Through the KFT screen, you can 
report multiple foreign transactions. (Press PAGE DOWN for a new KFT screen.)

Drake Tax generates a “Foreign Transaction Statement,” 
shown as “WK_FTRS,” (item #1 in figure at right), list-
ing all the foreign transactions for an S corporation. A 
separate “K-1 Foreign Transaction Statement” (“K-1 
STM FTR”; item #2 in figure at right) is also generated, 
reporting these foreign transactions for the individual 
shareholder. 
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Passing Through QBI Information

For tax years beginning after 2017, individuals, estates, and trusts that are sharehold-
ers in an S corporation may be entitled to a deduction of up to 20 percent of their 
Qualified Business Income (QBI) from a trade or business, plus 20 percent of quali-
fied Real Estate Investment Trust (REIT) dividends and qualified Publicly Traded 
Partnership (PTP) income. The deduction is subject to multiple limitations (such as 
the type of trade or business, the taxpayer’s taxable income, the amount of W-2 wages 
paid with respect to the trade or business, and the unadjusted basis immediately after 
acquisition of qualified property held by the trade or business) and can be taken in 
addition to the standard or itemized deductions.

The S corporation itself is not eligible for the QBI deduction; instead, the corporation 
must pass the necessary information through to its shareholders with a statement 
attached to Schedules K-1, separately identifying each trade or business, and – using 
the same box numbers as shown on Schedule K-1 – the amount of the following sepa-
rately stated 199A items:

• Section 199A QBI

• Rental Income (loss)

• Royalty Income (Loss)

• Section 1231 Gain (Loss)

• Other Income (Loss)

• Section 179

• Charitable Contributions

• Other Deductions

• W-2 wages

• Unadjusted basis of assets

• Qualified REIT dividends

• Qualified PTP income

• QBI allocable to qualified payments received from the specified cooperative

• Pass-through Domestic Production Activities Deduction (DPAD) under Section 
1099A(g) from a specified cooperative

So you can report this information, Drake Tax has included in the 1120S package 
screen 199A, Qualified Business Deduction by Activity. There are also the Quali-
fied Business Income (QBI) Deduction sections on screens F, RENT, and 8825. 

NOTE

Because charitable contributions are separately stated to the share-
holders, there is no “Charitable Contributions” line on the 1120S 
return. Charitable contribution information belongs instead on Sched-
ule K. Enter charitable contributions on the Deductions tab of screen 
K, in the line 12a - Charitable Contributions fields. (These are 
adjustment fields, adjusting entries made elsewhere in the return.) 
Any contribution limitation is made at the shareholder level.
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Drake Tax automatically produces the required statements with each shareholder’s 
Schedule K-1.

New for 2019: A check box added to screen 199A allows you to override the amounts 
calculated and flowing to the QBI worksheets. 

QBI Statements and Worksheets

(New for 2019) Drake Tax is including new worksheets with 1120S returns that report 
Qualified Business Income:

Statement A “Statement A – QBI Pass-through Entity Reporting” worksheet that includes Section 
199A items, will be attached to and filed with Schedules K-1 this year.

The “Qualified Business Income Information” worksheet – a summary of Statement A 
– will also be generated with the return. This worksheet will not be filed and is 
intended for the entity’s records.

Statement B “Statement B – QBI Pass-through Entity Aggregation Elections,” will be attached to 
and filed with Schedule K-1, and a “Qualified Business Income Aggregation” work-
sheet – a summary of Statement B – will be generated for entity’s records.

Statement C “Statement C – QBI Pass-through Entity Reporting,” will be attached to and filed with 
Schedule K-1, for patrons of specified agricultural and horticultural cooperatives. Cer-
tain patrons who conduct business through cooperatives may be able to include 
patronage dividends and similar amounts they receive from those cooperatives to cal-
culate their own QBI deduction. Specified agricultural or horticultural cooperatives 
are allowed a Section 199A(g) deduction for income attributable to domestic produc-
tion activities, which is similar to the domestic production activities deduction under 
former Section 199 before its repeal by the TCJA.

Denoting Service Trades or Businesses

Specified service trades or businesses are generally excluded from the definition of 
qualified trade or business. If the corporation is a Specified Service Trade or Business 
(SSTB), the shareholder could be subject to income limitations mentioned earlier; you 

NOTE

The program calculates relevant QBI information based on data 
entry. It is important that you review the calculated results and rely 
on your knowledge of this client's tax situation. The program 
assumes that the corporation operates as a single business entity 
and that all of the income on Form 1120S, line 21, “Ordinary busi-
ness income (loss),” is Qualified Business Income for purposes of 
computing QBI deductions. If the amount on line 21 is from more 
than one trade or business, use screen 199A to allocate QBI, W-2 
wages paid, UBIA, REIT dividends, and PTP income among the 
separate trades or businesses. If any of the amount on line 21 is 
not QBI, (for example investment income) use screen N199 to 
report that amount, and the W-2 wages paid, UBIA, REIT divi-
dends, and PTP allocated to that income.
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must, therefore, mark the box on screen 1 denoting that this S corporation is a “Speci-
fied Service Trade or Business,” if appropriate.

A specified service trade or business is any trade or business providing services in the 
fields of:

Also considered an SSTB:

• Any other trade or business where the taxpayer receives fees, compensation, or 
other income for endorsing products or services, for the use of the taxpayer's 
image, likeness, name, signature, voice, trademark, or any other symbols associ-
ated with the taxpayer’s identity, or for appearing at an event or on radio, televi-
sion, or another media format

• Investing and investment management

• Trading or dealing in securities, partnership interests, or commodities

Reporting Section 199A Items

Report the Section 199A items to be passed through to the shareholders on screen 
199A, Qualified Business Income Deduction. On that screen, if the corporation 
operates more than one business, select 1120S from the For drop list; otherwise, select 
from the For drop list the screen (K1P or K1F) that this activity pertains to.

Screen Codes: 
199A or K199

On each screen 199A, type in the EIN and name of the business, and be sure to mark 
the Treat as a “specified service business,” where appropriate. Type the Section 
199A information in the appropriate fields. To allocate the amounts and activities to 
the various shareholders, click the SA links. If reporting income data from more than 
one trade or business, press PAGE DOWN to allocate the data among the separate trades 
or businesses. 

Health Actuarial science Athletics

Law Performing arts Financial services

Accounting Consulting Brokerage services

NOTE

Report qualified business income from farms on screen F (Schedule F, 
Farm Income), in the Qualified Business Income section; for QBI from 
rental real estate, go to screen 8825 (Rental Real Estate); for QBI from 
rentals other than real estate, go to screen RENT (Rental Other Than 
Real Estate). These are all override fields; use them to override pro-
gram calculations.
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Figure 7: QBI fields on screen 199A

For screens 8825, RENT, and F, select Yes or No from the QBI drop list if this activ-
ity is a trade or business. (If this return was updated from Drake ’18, the field should 
be completed for you.)

Safe Harbor for Rental Properties

A rental real estate enterprise can be treated as a trade or business for purposes of sec-
tion 199A deduction. To qualify for this safe harbor, the enterprise must meet several 
requirements, among them:

• If 250 or more hours of rental services are performed each year in respect to this 
enterprise

• If separate books and records are kept for the enterprise

• The taxpayer maintains contemporaneous records

Commercial and residential real estate may not be part of the same enterprise for pur-
poses of meeting this safe harbor.

Open screen 8825 for each rental property. In the Qualified Business Income (QBI) 
section at the bottom of the screen, select “N” from the This activity is a trade or 
business drop list. Make a selection from the Rental real estate meets “safe har-
bor”... drop list. The program produces the Rental Real Estate Safe Harbor worksheet 
(“QBI SAFE” in View/Print mode.)

If a rental doesn’t qualify for the Safe Harbor, it might still qualify for the 199A 
deduction.

IMPORTANT For details on each type of income, read the field helps 
for all the Section 199A items.

NOTE
If Form 1120S is filed with no Section 199A information in box 20 (code 
Z) of Schedules K and K-1, the IRS will assume that no QBI data was 
generated from this partnership and will not allow the QBI deduction on 
the partner’s individual return.
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For complete details, see IRS Notice 2019-07.

Aggregation, BANs, and PBANs

An S corporation engaged in more than one trade or business may choose to “aggre-
gate” (combine) multiple trades or businesses into a single trade or business. In Drake 
Tax, use the Business Aggregation Number (BAN) fields to put these businesses 
together into one group or “aggregation.”

A BAN works just like other “grouping” numbers in Drake Tax, such as multiform 
codes and passive activity numbers. Enter the same number in the Business Aggrega-
tion Number (BAN) fields of the different businesses in the 1120S return – such as on 
screens 1, F, 8825, RENT, and 199A – and all trades or businesses with the same 
BAN are aggregated. To create more than one aggregation group, use a different BAN 
for each separate group.

Using BAN 
Fields and 

Screen

If this 1120S corporation is engaged in more than one trade or business, and you deter-
mine that some of the separate businesses that are reported on this tax return qualify 
for aggregation, and the corporation wants to aggregate them, then enter the same 
number in the BAN fields of the different businesses in the 1120S return – such as on 
screens 1, F, 8825, RENT, and 199A, then open the BAN screen (located on the 
Other Forms tab of the Data Entry Menu).

Screen Code: 
BAN

Enter the same BAN in the Business Aggregation Number (BAN) field on the BAN 
screen that you used for the other business that you are aggregating (on screens 1, F, 
8825, RENT, or 199A). Then, type in a name for the aggregated group. Finally, in text 
box 1 on the BAN screen, describe the relationship between the businesses and the 
factors met that allow the aggregation.

If there has been any change on the aggregation since the 2018 return, then, in text box 
2 of the BAN screen, describe the changes of fact or circumstance that have occurred 
since the prior year relating to an existing aggregation of the trade or business. (See 
the field help for both text boxes 1 and 2 for more information.)

NOTE

Aggregation and the use of the Business Aggregation Number 
(BAN) fields is still under development. When programming and testing 
is complete, this functionality will be activated with a Drake Tax program 
update.

The PBAN (Potential Business Aggregation Number) functionality has 
been activated. See “Potential BANs” on page 40.

IMPORTANT

Once an S corporation aggregates a group of trades or 
businesses, the shareholders must abide by that aggre-
gation. If the shareholders wish to choose their own 
aggregations, use the “Potential” Business Aggregation 
Number (PBAN) instead of the BAN. See “Potential 
BANs” on page 40 for more information.

NOTE See “Associating One Screen with Another” in Chapter 3 of the 2019 
Drake Tax User’s Manual for more on using multiform codes.
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To qualify for aggregation, the businesses must meet certain requirements (described 
in Publication 535 and in the field helps on screen BAN).

Potential 
BANs

On their Individual (1040) returns, shareholders have the choice to aggregate certain 
businesses into one entity for purposes of computing the Qualified Business Income 
Deduction (QBID). For that to happen, the corporation must tell the shareholders 
which trades or businesses might qualify to be aggregated. This is done by using the 
PBAN (“Potential Business Aggregation Number”) fields on screens 1, F, 8825, 
RENT, and 199A and the PBAN screen, available from the Other Forms tab of the 
Data Entry Menu.

The PBAN works just like the BAN and other “grouping” numbers in Drake Tax, such 
as multiform codes and passive activity numbers. All forms with the same PBAN can 
potentially be aggregated. (Shareholders can choose whether or not to aggregate and 
which trades or businesses can be in the aggregation. See the “IMPORTANT” note on 
page 39.)

Enter this same number in the PBAN fields of every appropriate screen for each busi-
ness on this return that potentially could be aggregated — including 1, F, 8825, 
RENT, and 199A. (See “Reporting Section 199A Items” on page 37.) In Figure 8, this 
trade can potentially be aggregated with others also using the PBAN “3.”

Figure 8: BAN and PBAN fields on screen 199A

Screen Code: 
PBAN

Complete screen PBAN (available on the Other Forms tab of the Data Entry Menu) 
for each potential aggregation of the trades or businesses. Enter the proper PBAN and 
provide an explanation of the factors met that allow the aggregation in accordance 
with Regulations section 1.199A-4. Use the same PBAN for the PBAN screen as on 
the other screens of this aggregation.

NOTE
Enter the same aggregation number in the BAN field on screen 1 as 
you did in the BAN fields of the other trades and businesses of the 
aggregation if you want this 1120S corporation aggregated with the 
other trades and businesses.
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If there could be two or more potential aggregations, press PAGE DOWN for a fresh 
PBAN screen.

Multiple trades or businesses can be aggregated into a single trade or business if they 
meet the following requirements:

• The taxpayer or a group of persons directly or indirectly own 50% or more of each 
trade or business for a majority of the tax year and all trades or businesses use the 
same tax year end.

• None of the trades or businesses is a specified service trade or business.

• The trades or business meet at least two of the following factors:

– They provide products or services that are the same or that are customarily 
offered together.

– They share facilities or share significant centralized business elements such as 
personnel, accounting, legal, manufacturing, purchasing, human resources, or 
information technology resources.

– They are operated in coordination with, or reliance upon, one or more of the 
businesses in the aggregated group.

Not 
Qualifying 

for QBI 

If any portion of the income or loss calculated on line 21 of Form 1120S is not trade or 
business income for QBI deduction purposes, open screen N199 (available from the 
Other Forms tab of the Data Entry Menu), and allocate the portion of the item that 
should not be included on Schedule K-1, box 17, code V.

Multiple 
Aggrega-

tions

It is possible to have more than one distinct aggregation group. To create a second 
aggregation, use another number in the PBAN fields of the second group. On the 
PBAN screen, press PAGE DOWN and include a description of the trade or business 
and an explanation of the factors met that allow the aggregation in accordance with 
Regulations section 1.199A-4. Use the second PBAN for this group.

Aggregated entities are listed in a statement with the shareholders’ Schedules K-1.

Oil and Gas Depletion Worksheet

The DEPL screen is accessible from the Other Forms tab of the Data Entry Menu. 
Create a separate depletion worksheet for each oil or gas interest. (Press PAGE DOWN 
to open a fresh instance of the DEPL screen.) Enter data for cost depletion, percentage 
depletion, or for both. If data for both cost and percentage depletion is entered, the 

NOTE
If this corporation potentially qualifies to be aggregated with any other 
businesses on this 1120S return, enter the same number in the PBAN 
field on screen 1 as you did on screen F, 8825, RENT, or 1099A for the 
other trades or businesses.

NEW FOR 

2019

The BAN Statement B will be attached to each Schedule K-1 in returns 
with aggregated businesses.

Aggregated businesses will be reported in a single column of the Quali-
fied Business Income Information worksheet (Wks QBI) with the 
“Aggregation” box at the top right of the Statement A marked.
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program does both computations and sends the one that gives the taxpayer the best 
deduction to the proper form or schedule. (Not all taxpayers have the option of using 
either method. Consult Publication 535 for additional information.)

Entries on the DEPL screen flow to the shareholders’ Schedule K-1, box 17, code A. 
The deductions from all of the worksheets are totaled and carried to the indicated form 
or schedule. When you view the return, the “Wks_DEPL” worksheets are listed in the 
forms tree on the left side of the View/Print window. 

Schedule K - Business Activities Statement

A Business Activities Statement (screen BAS) breaks down an S corporation’s Sched-
ule K items by business activity (Figure 9; listed in View/Print mode as “Wks BAW”).

A K-1 statement (“K-1 Wks BAW”) is also provided for the shareholders.

Figure 9: Business Activities Statement

Schedule K-1 for 1120S (Shareholder Information)

Use the K1 screen to enter personal information and ownership data for the sharehold-
ers for Schedule K-1, Shareholder’s Share of Income, Deductions, Credits, etc.

Officer and Shareholder Data Entry 

Enter information on corporation officers who are not shareholders on screen E (see 
“Compensation of Officers (Form 1125-E)” on page 19); for officers who are share-
holders, enter the officer’s title, percentage of ownership and participation, and com-
pensation information in the Officer Information section on screen K1. Data entered 

NOTE
The program calculates percentage of ownership based on the num-
ber of shares owned. (This amount can be overridden on the K1 
screen, using the Shareholder’s % of stock ownership field (below 
item “F”); however, this not recommended.)
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on the K1 screens flows to Form 1125-E, Officer Information, when Form 1125-E is 
required.

If the shareholder described on a K1 screen is the officer who signs the return for the 
corporation, mark the Signs Return check box in the Officer Information section. 
For the officer who keeps the books, mark that box. (See red circle in Figure 10.) This 
officer’s information does not have to be re-entered on the PIN screen. (The ERO 
PIN, the “sign’s return” officer’s PIN, and the Signature Date fields must still be 
completed on the PIN screen to be eligible for e-file.)

Schedule B-1 information can also be entered on the K1 screens.

Figure 10: Officer Information and Schedule B-1 fields on the K1 screen

Entity Name 
Field

Item E of the Shareholder Name and Address Information section of the K1 screen 
has a Name field for shareholders who are individuals, and an Entity name field for 
shareholders that are not individuals (estates, trusts, tax-exempt organizations, etc.). 
Putting a name in the Entity name field does not automatically change the type of 
shareholder; to do so, select from the Type drop list. 

Rounding 
Shareholder

Mark the check box on screen K1 to select which should be the “rounding” share-
holder. That shareholder will be the one who receives any balancing amount on 
Schedule K-1 when the return is calculated.

If you do not make a selection, the program designates as the rounding shareholder the 
last shareholder you entered. If you select more than one rounding shareholder, the 
program generates a Return Note informing you that:

• You have chosen more than one rounding shareholder

• The first shareholder you entered will be used as the rounding shareholder

Included in the Note is a list of all shareholders you have indicated as rounding share-
holders.

The rounding shareholder’s place in any sort is determined by the same criteria as the 
other shareholders when you choose a new sort order.

NOTE When you update a 2018 S corporation return in Drake Tax 2019, the 
information on last year’s OFF screen flows to the correct K1 screen.
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Sorting and Viewing Schedules K-1

View a return with multiple Schedules K-1 and 
you will see, in the forms “tree” on the left side 
of the View/Print window (in Enhanced View), 
that each shareholder has a “K-1” folder contain-
ing federal and state Schedules K-1 and any 
other forms, worksheets, and letters generated 
for that shareholder. Scroll down to a state to see 
similar K-1 folders for each shareholder.

For those who print their K-1 schedules, forms, 
worksheets, and letters from the Sets tab in 
View/Print mode, click Sets (red circle at top of 
Figure 11) and notice that each shareholder has a 
separate folder containing all generated federal 
and state K-1 schedules, forms, worksheets and 
letters (blue square in Figure 11), making it eas-
ier to print everything needed for the sharehold-
ers.

Click the PLUS SIGN [+] to expand the folder to 
see all documents relating to that shareholder. 
Click the MINUS SIGN [-] to collapse the folder 
again.

Figure 11: All K-1 documents listed under Sets tab

Set Viewing 
Order

By default, the order in which the shareholders are entered in the program is the order 
in which they are listed in View/Print mode and on any forms that list all shareholders 
for an S corporation. You can select the order in which the shareholders appear from 
the PRNT screen (available from the General tab or the Miscellaneous tab of the 
Data Entry Menu). From the Sort K1s by drop list, choose from Control, ID, First 
name, Last name, or Shares.

Screen code: 
PRNT

Choose to sort by first or last name and the shareholders will be listed alphabetically 
by the name you choose. (Shareholders that are estates, trusts, tax-exempt organiza-
tions, or disregarded entities will be listed by the first letter of the first word or name 
in the Entity name line of screen K1.)

Control 
Number

The Control number is an optional number you can use to identify and sort Sched-
ules K-1. The number can include up to five digits and decimals are allowed.

NOTE
Control numbers are direct entry only. Drake Tax does not automatically 
“increment” the control number. You have to enter a unique number on 
each shareholder’s K1 screen.
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Screen K1 
Overrides 

tab

Click the Overrides tab (Figure 12) at the top of the K1 screen to access the K-1 over-
ride fields.

Figure 12: The K-1 Overrides section available from the Overrides tab of the K1 screen

Ownership Changes

Ownership changes are entered on the OWN screen, which is accessible through the 
OWN Screen link on line “F” of the K1 screen or from the General tab of the Data 
Entry Menu. To use the OWN screen:

• Enter the date of ownership change at the top of the screen.

• Select the applicable shareholder from the Shareholder’s ID Number and Name 
drop list in the Change in Shares section. (The drop list consists of the names and 
ID numbers entered on the K1 screens and is updated automatically when a new 
name is entered on a K1 screen.)

• Enter the change in ownership of shares as a positive amount for an increase and a 
negative amount for a decrease.

• To enter additional ownership changes, press PAGE DOWN.

Printed Data A Summary of Stock Ownership worksheet (“Wks SOWN”) is generated in View/
Print mode, listing all shareholders, the numbers of shares owned, and the beginning 
and ending numbers of shares—including any changes in ownership. Because a share-
holder’s percentage of ownership may change even if the shareholder’s number of 
stocks owned does not, all shareholders are listed on the worksheet.

Worksheet “Wks OWN” is also generated for each shareholder who has changes in 
ownership shares.

NOTE
See field-level help for the Change in Shares field and FAQ item “P” 
in the program for more information on entering ownership-change 
information.
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IRS K-1 Codes

A code sheet can be printed with each Form 1120S K-1 to help the taxpayer interpret 
the various codes used on Schedule K-1. In Blank Forms (Tools > Blank Forms from 
the Home window menu bar), the code sheet is listed as “1120SK_1 Page 3.” To have 
this sheet printed automatically with all K-1 schedules, from the Home window of 
Drake Tax, go to Setup > Options > Form & Schedule Options tab and mark the 
Print Page 2 of Schedule K-1... check box, then OK. The codes can also be printed 
for a specific return by marking the applicable box on the PRNT screen, or by select-
ing “Schedule K-1 - Codes” from the forms “tree’ in View/Print mode.

The generated Schedule K-1 may include letter codes and asterisks:

• An asterisk with a letter code indicates that multiple items have that code.

• An asterisk at the bottom of a group indicates that there are more items than can fit 
in the space provided for that group and that a statement is attached, or that the 
statement is required (as in the case of “other” amounts).

Multiple Shareholders

For returns with a large number of 
shareholders, you have the option 
to deactivate calculation and print-
ing of the K-1s while working on 
Form 1120S. This option, which 
eases the process of reconciling the 
1120S, is available from the PRNT screen. Mark the box under K-1 Items to Sup-
press.

Before you file the return, go back to the PRNT screen, remove this check mark, then 
calculate the return.

Override Fields

It is not possible to override the calculations for a single shareholder’s Schedule K-1. 
To override calculated data, it is necessary to override the calculated amount on all 
Schedules K-1.

Foreign Addresses 

If the shareholder has a foreign address, enter Province/state, country, postal code 
information on the Foreign address line of the Shareholder Name and Address 

NOTE Schedule K-1 codes sheets are displayed in View/Print mode. 

IMPORTANT
Shareholder overrides should not be used for an S cor-
poration except in certain circumstances, such as own-
ership changes.
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Information section (along with the street address and city in the Address and City 
fields) of screen K1. Do not enter anything in the U.S. State or ZIP fields. Con-
versely, for a U.S. address, do not enter anything into the foreign address fields.

K-1 Export

Take the following steps to export K-1 information from an 1120S return into the K1S 
screen of a 1040 return:

1. Ensure that K-1 data is entered in the 1120S return and that the 1040 return has 
been created in Drake Tax. (The K1S screen in the 1040 does not have to be cre-
ated beforehand.)

2. In the 1120S return, go to View/Print mode.

3. Click K1 Export in the View/Print toolbar. If any K-1s are not eligible to be 
exported, that list appears. Click Next to continue; otherwise, the Export K1s 
window is opened, containing a list of K-1s eligible for export.

4. Remove the check mark from the box to the left of any SSNs you do not wish to 
export.

5. Click Export. When the export is complete, click OK.

The K-1 data will be displayed in the 1040 return in the program. 

K-1 Import

The K-1 Import feature can import K-1 data from partnership or fiduciary returns into 
the K-1 “source” screens (K1P and K1F) of the 1120S package.

1. Open the partnership (1065) or fiduciary (1041) return in Drake Tax and view the 
return.

2. Click the K-1 Export button from the View/Print toolbar. If any K-1s are not eli-
gible to be exported, that list appears. Click Next to continue; otherwise, the 
Export K1s window is opened, containing a list of K-1s eligible for export.

3. Remove the check mark from the box to the left of any TIN you do not wish to 
export.

4. Click Export.

5. When the export is complete, click OK.

The K-1 data flows to the K1P or K1F screen in the 1120S return.

NOTE
The Foreign fields are locked when a return is opened. Click in one 
of the fields to unlock them throughout the return. To relock the 
unused Foreign fields, close and then reopen the return.

NOTE
Basis information for individual shareholders should be entered in the 
1040 package in Drake Tax; this information cannot be exported from 
the 1120S package to a 1040 return. Such an import would override 
limitations and carryovers calculated in the 1040 program.
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An Additional 
Entries tab (figure 
at left) on the K-1 
source screens in 
the 1120S return 
offers 40 more 
fields for entering, 
importing, and 
exporting addi-
tional K-1 items

Supplemental Information

Two types of supplemental information can be added to Schedules K-1:

• Supplemental data for all K-1s in a return

• Supplemental data for a single K-1 in a return

To add supplemental information “globally” (to all K-1s), from the Data Entry 
Menu, open screen K1G (Global Supplemental Information) and enter the informa-
tion in the Supplemental Information text box. This information appears on all 
printed shareholder K-1s.

To add supplemental information to an individual K-1, open a shareholder’s K1 
screen and click the blue Supplemental Info link at the top of the window. In the text 
box (Figure 13), enter information pertinent to this shareholder. When the return is 
printed, this information appears on only this shareholder’s K-1. 

Figure 13: In this example, the information entered on the K1S screen, Supplemental Info
tab, appears on only the K-1 of the shareholder with SSN of 123123123.

Domestic Production Activities Deduction
Beginning in 2018, a taxpayer is eligible for the DPAD on the federal 1120S return only if it is 
passed through from a fiscal-year corporation with a tax year that began in 2017. If the DPAD 
is not from a pass-through fiscal-year entity, complete screen 8903 only if it is needed on the 
state return.
48 Tax Year 2019



Drake Tax Manual Supplement: S Corporation Schedule K-1 for 1120S (Shareholder Information)
K-1 Cover Letters

K-1 cover letters can be produced to accompany each Schedule K-1 in a return. You 
can set up the global option to produce K-1 cover letters for all returns containing K-1 
schedules, or you can choose the option on a per-return basis.

Producing 
Letters for 

All Returns

To have the K-1 cover letters produced automatically with all applicable returns, from 
the Home window menu bar of Drake Tax, go to Setup > Options. Under the Client 
Communications tab, on the bottom-left of the window, mark the box labeled 
Include K-1 letter with returns, then click OK.

From the K-1 Letterhead drop list, choose to print the corporation’s information in 
the letterhead, print your firm’s logo and information in the letterhead, or to have nei-
ther the corporation’s or firm’s information printed in the letterhead.

The K-1 letters are signed by the officer selected as “Signs return” on screen E, or if 
no officer is selected on screen E, a shareholder selected as “Signs return” on a K1 
screen becomes the signer of the K-1 letters. (If both an officer on screen E and a 
shareholder on screen K1 are selected as “Signs return,” the selection on screen E 
overrides the selection on a screen K1.)

Screen codes:
COMM or K1L 

To have some other shareholder or officer sign the K-1 letter, in each return complete 
the Name and Title fields at the bottom of the COMM screen (available on the Mis-
cellaneous tab). (To have some other shareholder or officer sign the return, complete 
the Signature and Title override fields on the PIN screen.)

Producing 
Letters for 

Single 
Return

If no default has been set to produce K-1 cover letters with all returns, you can take the 
following steps to generate letters for a single return:

1. Open the return and go to screen COMM (accessible from the Miscellaneous tab 
of the Data Entry Menu).

Type COMM or 
K1L in selector 
field and press 
ENTER.

2. At the bottom of the screen, enter the name and title of the person who will be 
signing the K-1 cover letter.

3. (optional) The default selection for the letterhead of the K-1 letter is the name and 
address of the S corporation. To have your firm’s contact information and logo 
printed in the letterhead of the K-1 cover letters instead, open the COMM screen, 
select Print firm info/logo from the Information on the K-1 coversheet... drop 
list at the bottom of the screen.

4. (optional) Select Don’t print entity or firm info from the Information on the K-
1 coversheet... drop list at the bottom of the COMM screen and no letterhead 
information will appear at the top of the K-1 letters.

NOTE
Before a corporation’s information can be printed on the K-1 letter, you 
must go to Setup > Communications Editor, and from the toolbar, 
select Setup > Page Layout and select Use letterhead on letters. 
The letterhead is derived from data entered on screen 1.

NOTE
Before a corporation’s information can be printed on the K-1 letter, you 
must go to Setup > Communications Editor, and from the toolbar, 
select Setup > Page Layout and select Use letterhead on letters. 
The letterhead is derived from data entered on screen 1.
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Once the required signing information has been entered, a K-1 cover letter will be 
generated for each shareholder receiving a K-1.

Editing the 
K-1 Letter

As with other letters provided by the program, you can edit the text to suit your office 
needs and style.

To edit the text of the K-1 letter:

1. From the Home window menu bar in Drake Tax, select Setup > Communica-
tions Editor. The Client Communications Editor is displayed.

2. From the icons on the toolbar, select Open > S Corporation > Sub S K1 Cover 
Letter to view the template of the S corporation K-1 letter.

3. Make any desired changes to the template.

4. Click Save.

Shareholder’s Adjusted Basis Worksheet

Use the Shareholder’s Adjusted Basis Worksheet (Basis Wks tab of the K1 screen; 
Figure 14 on page 51) to calculate a shareholder’s new basis after increases and 
decreases are made during the current year. The basis of S corporation stock is 
adjusted on an ongoing basis (unlike for a “C” corporation, where stock basis remains 
constant unless additional stock purchases are made or stock is sold). A shareholder’s 
beginning basis in S corporation stock is the original capital contribution.

TIP
Review the following sections of the 2019 Drake Tax User’s Manual 
before making changes to letter templates:

• “Introduction to Letters in Drake Tax” in Chapter 2, “Installation & Setup”

• The “Letter Keywords” section of Appendix B, “Keywords”

NOTE
For an amended return, the K-1 letter automatically refers to the 
amended K-1. To edit the letter for an amended K-1, from the Commu-
nications Editor toolbar select Open > S Corporation > Sub S K1 
Amended and follow steps 3 and 4 of the previous procedure.

NOTE
Basis information for individual shareholders should be entered in the 
1040 package in Drake Tax; this information cannot be exported from 
the 1120S package to a 1040 return. Such an import would override 
limitations and carryovers calculated in the 1040 program.
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Figure 14: K1 screen tab for accessing the Adjusted Basis Worksheet

Increases 
and 

Decreases

Increases to basis can include additional stock purchases and capital contributions, 
separately stated income (including tax-exempt income), and depletion in excess of 
basis of property.

Decreases to basis can include distributions of cash or property to shareholders, sepa-
rately stated losses and deductions, nondeductible corporation expenses, and credit 
adjustments.

Annual 
Update of 

Shareholder 
Information

When the program is updated to the next tax year, the end-of-year basis and share-
holder loan amounts are automatically updated to the beginning of the new year. Any 
loss/deduction carryover is updated to the beginning of the year and its character 
(ordinary loss, section 179 expense, charitable contributions, etc.,) maintained. The 
program also tracks the amount of debt applied to losses and the total amount of loss 
carryforwards.

Schedule L: Balance Sheet Per Books

Schedule L is required if the corporation’s total receipts for the tax year or its total 
assets at the end of the year are greater than $250,000.

Schedules L and M-2 

Schedule L and Schedule M-2 reconciliation totals are displayed on screens L and M2 
to facilitate reconciliation of the balance sheet (item #1 in Figure 15 on page 52).

NOTE If a K1 screen is marked as final, none of the related screens for that 
shareholder is updated for the next year.

NOTES

To force the program to print Schedule L even if not required, mark 
the Force-print Schedules L and M-1 box on screen L or on the 
PRNT screen.

With the Trial Balance Import feature, you might not need to use 
screen L at all. See “Importing Trial Balance Information” on 
page 74.
Tax Year 2019 51



Schedule L: Balance Sheet Per Books Drake Tax Manual Supplement: S Corporation
Figure 15: Beginning- and End-of-Year totals displayed on L screen (#1);
force printing end-of-year totals (#2)

Note that the totals from the balance sheet’s subsidiary schedules (SCH2 screen) also 
appear in the BOY Totals and EOY Totals columns of the L screen. (See “The SCH2 
Screen,” below, for more on using this screen.)

If you make any changes to the data, recalculate the return (press CTRL+C) for those 
changes to be displayed on the screen.

Force-Printing Final End-of-Year Totals

Normally, if you mark Final on screen 1, the program “zeros out” the EOY Totals 
column of Schedule L. Mark the check box on screen L (item #2 in Figure 15) to force 
those totals to be displayed in the EOY Totals column.

Flow of Information

Many of the entries made elsewhere on the return flow automatically to the generated 
Schedule L (for example, inventory information from Form 1125-A). Depreciable 
asset information from the 4562 screen and intangible assets and amortization also 
flow to Schedule L.

The SCH2 Screen

The SCH2 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule L. This screen can be used in place of the actual L screen in the 

TIP
To speed up calculation of returns that contain multiple states, open 
screen 1 and select 0 from the Resident state drop list. Before filing, 
but sure to return to screen 1, make a selection from the Resident 
state drop list, and then recalculate.
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program. In other words, if you use this screen for all applicable lines on Schedule L, 
you do not need to make any entries on the L screen.

To create a statement for a line, select a line from the Line Number drop list of screen 
SCH2 and enter a description and its corresponding amount. Once the information is 
entered, press PAGE DOWN to access a new SCH2 screen. If more detail is required 
than can fit into a Description field, press PAGE DOWN, and on the new SCH2 screen, 
select the same line number and then add to the description. 

Statements The total of all amounts entered on the SCH2 screens appear on the L screen in the 
BOY Totals and EOY Totals columns. They are also printed on the return as applica-
ble, with references to the corresponding statements.

If a line is required, a statement (labeled “STATEMENT” or “STM” in View/Print 
mode, depending on your Setup Options) is produced and is e-filed with the return. 

Note that an e-fileable “STATEMENT” is referenced in Schedule L of the return, as 
shown in the example of Figure 16.

Figure 16: A selection of “Other Current Assets” from the Line Number drop list of
screen SCH2 (top figure) attaches a statement and is referenced on the applicable line 

of Schedule L (bottom figure).

SCH2 and 
Trial Balance 

Typically, one or more SCH2 detail screens is needed for Schedule L items. If you are 
using Drake Tax’s trial balance worksheet feature, be aware that data for the SCH2 
screens cannot be entered directly into the trial balance worksheet, and it cannot be 

NOTES

When a return is updated from one year’s version of Drake Tax to 
the next – such as from 2018 to 2019 – all line selections are car-
ried to the SCH2 screen, with prior year’s year-end amounts flow-
ing to the beginning-of-year column in current year’s program.

To access the SCH2 screen from the L screen, click one of the 
SCH2 Screen links. The SCH2 screen is also available from the 
General tab of the Data Entry Menu.
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imported into the data entry. The SCH2 detail screens must be created apart from the 
trial balance worksheet.

When the return is produced, Schedule L reflects both the amounts imported from the 
trial balance worksheets (where direct entry was allowed) and the totals of the SCH2 
screen amounts.

For more information, see “SCH2 Detail” on page 82.

Autobalance

Autobalance forces Schedule L to balance for both the beginning- and end-of-year 
amounts. The program adjusts the unappropriated retained earnings amount on Sched-
ule L by the difference between the total assets and the total liabilities and capital 
before the adjustment.

(Example: If Assets = $1,000, and Liabilities and Capital = $900, the program 
increases the unappropriated retained earnings by $100.)

The program makes the adjustment due to differences in the balance sheet. These dif-
ferences can come from amounts entered incorrectly but are usually the result of one 
of the following causes:

• An asset was deleted from the 4562 screen (Depreciation Detail) instead of being 
indicated as sold.

• Beginning inventory amounts were adjusted on screen A, or ending inventory 
amounts were entered incorrectly.

• Amounts were erroneously deleted from or changed on screen L.

To reconcile the differences, it is best to compare the corporation’s beginning and end-
ing balance sheet amounts for the tax year.

To deactivate the autobalance feature for a specific return, go to the PRNT screen and 
select Turn off autobalance.

Schedules M-1, M-3 (Reconciliation of Books/Return)

Schedule M-1 is required if the balance sheet’s total assets at the end of the year are 
greater than $250,000. Page 1 of Schedule M-3 is required if the balance sheet’s total 
assets at the end of the year equal or exceed $10 million, and Schedule M-1 and pages 
1-3 of Schedule M-3 are required if the total assets equal or exceed $50 million.

Schedule M-1

Schedule M-1 shows all items of income and expense that are not subject to tax, plus 
those accounting items that are not income tax items. When required, taxpayers must 
reconcile book income with taxable income.
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Use screen M1 to enter book-to-tax difference for Schedule M-1. Book-to-tax differ-
ences are classified as permanent or temporary, and as favorable or unfavorable. 
Examples of both kinds of differences are shown in Table 2.

Depreciation 
and 

Amortization 
Adjustments

The program may make an adjustment for book-to-tax depreciation (or amortization) 
differences. The calculation is done as described in the following steps. (This proce-
dure refers to “depreciation” throughout, but it applies for either depreciation or amor-
tization.)

1. The amount reported on Schedule L “Beginning of Year” accumulated deprecia-
tion (line 10b, column a) is subtracted from the “End of Year” accumulated depre-
ciation (line 10b, column c). This is the “book” depreciation amount.

2. This “book” depreciation amount is compared to the “tax” depreciation amount. 
(The “tax” depreciation amount is calculated from the Forms 4562, including any 
section 179 amounts.)

3. The difference between the “book” and “tax” depreciation amounts is carried to 
the appropriate form and line.

• If the “book” depreciation amount is greater than the “tax” depreciation 
amount, the difference flows to one of the following locations:

– Schedule M-1, line 3a

– Schedule M-3, Part III, line 24 (as a negative amount)

– Form 8916-A, line 2l (as a negative amount for assets selected on the 
4562 detail screen for COGS)

• If the “tax” depreciation amount is greater than the “book” depreciation 
amount, the difference flows to one of the following locations:

– Schedule M-1, line 6a

– Schedule M-3, Part III, line 24 (as a positive amount)

– Form 8916-A, line 2l (as a positive amount for assets selected on the 4562 
detail screen for COGS)

Table 2: Examples Book-to-Tax Differences for Schedule M-1

Difference Description Examples

Permanent Book or tax items that will never be 
reported for book or tax purposes

- Meals & entertainment limitations
- Penalties
- Tax-exempt interest

Temporary Items that will be reported for both 
tax and book purposes, but not 
during the same tax year

- Depreciation
- Gains or losses on the sale of 

depreciated assets

Favorable Items that reduce taxable income - Instances in which tax depreciation 
amount is greater than book depre-
ciation amount

Unfavorable Items that increase taxable income - Disallowed meals & entertainment
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Schedule M-3

Any domestic S corporation or group of corporations that reports on Schedule L total 
assets at the end of the corporation’s tax year that equal or exceed $50 million must 
complete and file Schedule M-3 instead of Schedule M-1. If the S corporation is 
required to file (or voluntarily files) Schedule M-3, it must file Form 1120S and all 
attachments and schedules, including Schedule M-3.

Accessing 
the M3 

Screens

The Schedule M-3 section of the General tab of the Data Entry Menu provides 
direct access to the following screens:

• M3, M32, and M33 — for Parts I, II, and III of the Schedule M-3

• M3S — for supplemental statements

• SCH3 — for subsidiary schedules for Schedule M-3 and Form 8916-A

• 8916 — for Form 8916-A, Supplemental Attachment to Schedule M-3

Certain income, deductions, gains, and losses flow from Form 1120S to Schedule M-3 
in the program, but all other M-3 data must be entered manually on the M3 screens.

 Screen 
SCH3

The SCH3 screen is similar to the SCH2 screen and is used to provide detailed infor-
mation for Schedule M-3 and Form 8916-A. It can be used in place of the actual M3 
and 8916 screens.

For more information on using this type of screen, see “The SCH2 Screen” on 
page 52.

Schedule M-2 (Analysis of Accounts)

For an S corporation return, Schedule M-2 is the analysis of the Accumulated Adjust-
ment Account. Schedule M-2 information can be entered on the M2 screen and else-
where in the program, but most information flows to the M-2 automatically. See 
“Entering Distributions” on page 57.

Schedule M-2 represents a corporation “picture” of the income, losses, and distribu-
tions to shareholders and tracks tax-free distributions and helps determine if excess 

NOTE
Parts II and III of Schedule M-3 reconcile financial statement net 
income (loss) for the U.S. tax return (per Schedule M-3, Part I, line 11) 
to total income (loss) on Form 1120S, page 3, Schedule K, line 18.

NOTE

If the corporation’s assets do not equal or exceed $10 million but the 
corporation wants to voluntarily file Schedule M-3, or if the corporation’s 
assets do not equal or exceed $50 million but the corporation wishes to 
file the complete Schedule M-3, go to screen M3 and make a selection 
from the Force print M-3 drop list. Choose to print just page 1 of 
Schedule M-3 or the complete M-3.

NOTE On an 1120S return (unlike an 1120 return), Schedule M-2 is not a 
reconciliation of retained earnings. 
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distributions might be taxable to shareholders. If a shareholder receives more in distri-
butions than he or she has in basis, the result might be taxable.

Entering Distributions

Code Section 6037 states that an S corporation return must report the amount and date 
of distributions made to each shareholder. Use the DIST screen for reporting date and 
distribution amounts for Schedule K, line 16d, “Distributions.” In addition to line 16d, 
the total from the DIST screen may flow to Schedule M-2, line 7 (subject to limita-
tions) and to the Schedules K-1 based on the shareholder’s ownership percentage. 
Schedule K-1 distribution information is displayed on the “K1_Dist” worksheet pro-
duced with the return.

Column A, Accumulated Adjustments Account

The “Accumulated adjustments account” column of Schedule M-2 generally reflects 
the S corporation’s accumulated undistributed net income after 1982. Non-dividend 
distributions flow to Schedule M-2 from Schedule K, line 16d. An entry in the “Non-
dividend distributions” line of the M2 screen adjusts the amount from the K screen 
(subject to limitations; see balance-sheet examples on the following page). See the 
field help for column a of line 7 on screen M2 for more details.

Distributions reported on line 7 flow differently from the amount entered on the DIST 
screen. (See the previous section, “Entering Distributions.”) The distributions are lim-
ited following the ordering rules under Reg §1.1368.2.

These rules are for Schedule M-2, column (a):

• Line 1 balance — The balance at the beginning of tax year, line 1 is either 
“0” (zero) or the balance carried forward from line 8 of the previous year. Due 
to prior-year net losses and reductions, the amount on line 1 can be negative.

• Changes to AAA — The Accumulated Adjustments Account (AAA) is 
increased for “ordinary income from page 1, line 21” (line 2 of M-2) and other 
additions listed on line 3. The AAA is then decreased for any loss from page 
1, line 21 (line 4 of M-2) and other reductions listed on line 5.

• Reduction of AAA — Once these adjustments are made, the AAA is reduced 
by ordinary distributions on line 7, but not less than “0.” Thus, if the distribu-
tions are $20,000, but the net amount on line 6 is $10,000, line 7 is limited to 
$10,000. If line 6 is a negative number, then line 7 will be “0” (in this exam-
ple). To allow an amount on this line would take the AAA to a larger negative 
number. (That is, even more below zero than it really is).

NOTE The DIST screen is available from the General tab of the Data Entry 
Menu, or enter DIST in the selector field and press ENTER.

TIP See Form 1120S instructions for more details and examples.
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The rules from the preceding chart apply when the net adjustment for lines 2 through 5 
is positive. When the net adjustment for lines 2 through 5 is negative, the ordering 
rules are switched and AAA is decreased by ordinary distributions (but not below 
zero) before the net negative adjustment for lines 2 through 5.

Important 
Note about 

the AAA

A corporation can make distributions greater than the amount on line 6 of the M-2, but 
those distributions could be taxable for the shareholders. Enter distributions on the 
DIST screen; this way, the amounts flow automatically to Schedules M-2 and K-1 but 
are limited based on the rules described previously. (For more information on the 
DIST screen, see “Entering Distributions” on page 57.)

Line 7 is limited to the lesser of the amount for line 7 or the positive amount from line 
6. If line 6 is negative, line 7 is then limited to the positive amount on line 1. If line 1 
and line 6 are both negative, line 7 is disallowed on Schedule M-2. Distributions are 
entered on the DIST screen to be reported to the shareholders, regardless of the 
Schedule M-2 limitation.The AAA cannot be negative as a result of distributions, but 
it can be negative if it arises from losses.

Column B, Undistributed Taxable Income Previously Taxed

The total of column (b) cannot be negative. This column is active in an 1120S only if 
the entity was ever a “C” corporation (thus having earnings and profit (E&P)) or if it 
was a pre-1983 S corporation. By design, Drake Tax does not allow negative numbers 
in column (b).

If a corporation becomes an S corporation and has net operating losses (NOLs), the 
NOL is not generated for the return because it cannot be carried to an 1120S (the IRS 
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does not want the NOL to be used by the shareholders to offset income); it either runs 
out within the years allowable for the NOL by statute or is used if the S corporation 
terminates its “S” status within those years.

Column C, Accumulated Earnings and Profits

If the corporation was a C corporation in a prior year, or if it engaged in a tax-free 
reorganization with a C corporation, enter the amount of any accumulated earnings 
and profits (E&P) at the beginning of its 2019 tax year. If the corporation made distri-
butions from accumulated earnings and profits, enter the amount of such distributions 
on Schedule K, line 17c. The amount entered on Schedule K, line 17c flows to Sched-
ule M-2, line 7.

Column D, Other Adjustments Account

Use column D, Other Adjustments Account, of screen M2 to enter any amounts you 
want printed in the corresponding column of the printed return. Officer life insurance 
and applicable tax-exempt income flow to Schedule M-2, column b (“Other adjust-
ments account”), line 5. All other amounts (such as expenses) must be entered manu-
ally on the M2 screen.

Rental Activities

Income and expenses for rental real estate properties appear on Form 8825, Rental 
Real Estate Income and Expenses of an S corporation. To make entries in Drake Tax, 
use the 8825 screen, available from the Other Forms tab of the Data Entry Menu.

Screen Code: 
8825

If there are multiple 8825 properties, press PAGE DOWN for a new 8825 screen. Use 
one screen per rental property. If a return has more than one 8825 screen, the program 
reports each property’s information on a separate column of the “Properties” section 
of Form 8825 (up to eight properties can be included on a form). Data from all 8825 
screens are transmitted to the IRS when the return is e-filed.

Line 14, Depreciation

If the program is calculating depreciation (entered on the 4562 screen) for the property 
listed on Form 8825, do not enter the depreciation on the 8825 screen. Depreciation 
should be entered on screen 8825 only if it is figured outside of the Drake Tax pro-
gram, and then only the net results should be entered.The amount entered on line 14 of 
screen 8825 is added to the depreciation calculated from the 4562 screens.

NOTE Special steps are required for using the trial balance worksheet for mul-
tiple rentals. See “Rental Expenses” on page 84.

NOTE Form 4562 is required for assets placed in service during the year.
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 Information 
Flowing to 
Form 8825

To indicate that the information should flow to Form 8825, select 8825 from the For 
drop list on screen 4562 (Figure 17). If there are multiple 8825 screens, use the Multi-
form code box. Any depreciation information entered on the 4562 screen flows to the 
correct Form 8825, based on the form and multi-form code selections at the top of the 
4562 detail screens.

For information on using the Multi-form code box, see the 2019 Drake Tax User’s 
Manual.

Figure 17: In this example, the 4562 information flows to the second 8825 screen created.

Any depreciation information entered on the 4562 screen flows to the correct Form 
8825, based on the form and multi-form code selections at the top of the 4562 detail 
screens.

Information 
Flowing from 

Form 4797 

If the corporation sold rental property, and screen 4797 is completed, data flows from 
Part II, line 17 of Form 4797, to the first Form 8825, line 19, “Net gain (loss) from 
Form 4797, Part II, line 17, from the disposition of property from rental real estate 
activities.”

Line 15, Other Expenses

Enter meals and entertainment (subject to 50% limit) in the appropriate field on line 
15 of the 8825 screen. To enter additional other expenses, begin typing into the Addi-
tional other expenses field to open a Detail (CTRL+W) Worksheet. Enter descriptions 
and amounts on this worksheet. 

A statement from each 8825 property is printed with the return (Figure 18 on page 61) 
and is submitted to the IRS when the return is transmitted.

IMPORTANT

When selecting a multi-form code, note that the code 
should refer to an 8825 screen—not the 8825 form. For 
example, data from the second 8825 screen will be gen-
erated on the first Form 8825. To associate an asset with 
that information, you would enter 2 for the screen (not 1 
for the form) in the Multi-form code box. For more infor-
mation on Form 8825, see “Viewing Rental Activity Infor-
mation” on page 61.

NOTE Drake Tax produces a Form 4562 for each property on Form 8825.
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Figure 18: Other expenses are listed on Form 8825 and on accompanying statements;
in this instance, “STM 8825_01,” “STM 8825_02,” and “STM 8825_03”

If more than three 8825 screens have detail worksheets included for the Additional 
other expenses field, “Form 8825 - Attachment” is generated in View/Print mode, 
listing all properties for which a screen 8825 was completed that include these addi-
tional other expenses, and listing the statements generated for each.

Use the K1P screen to enter rental income the S corporation receives on a Schedule 
K-1. This amount flows to Form 8825, lines 20a. No entry is required on the 8825 
screen.

Qualified Business Income on Screen 8825

If this rental activity is a trade or a business, select “Yes” from the This activity is a 
trade or business drop list in the Qualified Business Income (QBI) section of the 
8825 screen. For a possible aggregation of business for the shareholder’s individual 
return, type an appropriate number in the Potential Business Aggregation Number 
field. For more information on using these fields, see “Passing Through QBI Informa-
tion” on page 35 and “Aggregation, BANs, and PBANs” on page 39.

Viewing Rental Activity Information

Rental activity data is viewed on the 8825 forms and accompanying statements.

• 8825 Forms — The two-page Form 8825 can contain information for up to 
eight rental activities. Each Form 8825 in View/Print mode contains up to 
eight rental activities. If more are entered, a second Form 8825 is created (see 
figure on next page).

NOTE  The This activity is a trade or business drop list is a required field 
and must be answered for each 8825 activity.
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• Form 8825 in View/Print 
mode consists of one or 
more pages (depending on 
the number of rental activi-
ties) listing up to four rental 
activities per page. If more 
than four rental activities 
are entered, scroll down to 
the second page of the 
Form 8825 when viewing.

• 8825 Statements — 
Depending on your selec-
tions at Setup > Options, 
statements are titled 
STM_8825_XX, where XX equals the instance of the 8825 screen. (For 
example, the statements for the first and second 8825 screens would be 
labeled STM_8825_01 and STM_8825_02, respectively.) There are also 
8825 attachments (8825_ATT) for reporting other information.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. The required 
adjustments flow to the appropriate line of the return and to either Schedule M-1 or 
Schedule M-3.

Manually reducing the expenses or deductions or increasing the income for these 
credits causes the return to be out of balance.

See “Credit Adjustments” on page 18 for more.

Elections

Screen code: 
ELEC

The ability to make certain tax elections is included in the business packages. Elec-
tions are selected from the Election drop list on the ELEC screen.

Making an Election in Drake Tax

To indicate that the S corporation is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry 
Menu or by typing ELEC in the selector field of the Data Entry Menu and 
pressing ENTER.)

2. Make a selection from the Election drop list (Figure 19 on page 63).
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Figure 19: Election drop list

3. Complete all other fields as applicable. Press F1 in any field to learn if that field is 
required for your selection and the type of information needed. For example, the 
help text for the Other date or year-ending field shows that the field is required 
only for election options 15, 27, 28, 29, and 31, and it explains what, specifically, 
should be entered for each of these elections (Figure 20).

Figure 20: Help text for Other date or year-ending field on ELEC screen

To open a new ELEC screen for an additional election, press PAGE DOWN.

NOTE
If the election option you selected is not listed in the help text for a field, 
that field should be left blank. For example, if you chose election 01 
(General Election Statement), you would not need to enter anything 
into the Date or year-ending field (help text in Figure 20).
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Election Statements

Once an election is made and the return is calculated, the election information is pro-
duced on a statement referenced either as “STATEMENT” or “Statement ELXX” 
(where “XX” is the number of the election) depending on your selections in Setup 
Options. For example, election 01 (General Election Statement) is generated as “State-
ment EL01” if you select Print only one overflow statement per page at Setup > 
Options > Calculation &View/Print tab, or in one of the “STATEMENT” pages if 
you clear the Print only one overflow statement per page check box.

The election statement includes the election title, election wording, and any additional 
information required for the election, such a date or amount.

Entries for certain fields are sometimes included in the actual election statement; other 
times, they are included as separate lines. Signature lines are printed as needed on 
some statements.

Safe Harbor Elections

Use the Building qualifies for Section 1.263... check box on screen 4562 to apply a 
small taxpayer Safe Harbor election to a building listed in the Description field. An 
election statement (“Election Stmt”) is produced and the building description as 
entered in the Description field is included in the election statement.

See IRS Reg. section 1.263(a)-3(h), IRB 2013-43, Rev. Proc. 2014-16, and Rev. Proc. 
2015-14 for guidance. 

Making Changes on the Fly

Use the PRNT screen, as described in the following paragraphs, to override program 
defaults.

Suppressing/Forcing Items

Screen Code: 
PRNT

To suppress the printing or production— or to force the printing or production—of 
certain documents, go to the PRNT screen and select the desired options. Many “on-
the-fly” changes override the options established in Setup Options.

1120S Items These items can be “forced” (forcing the program to generate the item) on a return:

• 1125E Officer Information

• Schedules L and M-1

• Form 4562 (Depreciation and Amortization)

• Next-year depreciation listing

• Inactive returns (“Inactive return” printed on first page of the 1120S)

NOTE This Safe Harbor election covers buildings only.
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• Preparer and officer signature on printed copy of return

The following 1120S items can be “suppressed” (kept from being generated) on a 
return:

• Schedule M-2

• WK_M2 (Retained Earnings Reconciliation Worksheet)

• Form and worksheet references

• Proformas for the next tax year

K-1 Items The following K-1 items can be “forced” on a return:

• Shareholder’s adjusted basis worksheet (Wks SBAS)

• K-1 codes (page 2 of the Schedule K-1)

The following K-1 items can be “suppressed”:

• Related documents: Schedule K-1, K-1 cover letter, K1 ATT worksheet (for K-1 
statement overflow), and shareholder’s adjusted basis worksheet (Wks SBAS)

• Marking of “Amended K-1” box on printed Schedule K-1

• K-1_DIST worksheet

Overriding Other Setup Options

Screen Codes: 
COMM or LTR

Filing instructions and envelope coversheets can be either forced or suppressed from 
the COMM screen to override the global setting in Setup > Options (from either on 
the Optional Documents tab or the Client communications tab).

The PRNT screen also includes options to disable autobalance (see “Autobalance” on 
page 54), calculate the Form 2220 penalty, and prepare an extension (Form 7004) 
based on the data entered on screen 1. (See “Filing an Extension” on page 27.)

Optional (but Recommended) Security Information

Screen Code: SEC The Filing Security Information screen (SEC) in Drake Tax is part of an ongoing 
IRS initiative to protect the business and tax return preparers from data theft and tax 
fraud. The information entered on the SEC screen is transmitted when the tax return is 
e-filed. Completing this screen for federal returns is strictly optional for 2019; how-
ever, certain states will begin requiring this information in the near future.

Screen (SEC) is accessible through a link on screen 1 or from the Data Entry Menu.

NOTE
Form and worksheet references are for the benefit of the preparer 
and client but are not required for the tax return. References appear 
on tax forms to clarify which worksheets (available in View/Print 
mode) correspond to which calculations, and which forms/screens 
certain amounts are carried from.
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Electronic Filing

Steps to e-file Form 1120S are the same as to e-file Form 1040, with the exception of 
bankruptcy returns, which must be paper-filed.

Calendar year returns are due on March 16, 2020. Fiscal-year returns are due on the 
15th day of the third month (two and a half months) after the S corporation’s year end. 
Returns can be e-filed after these dates; however, if an extension has not been filed, 
penalties and interest are applied.

EF “Notice” and EF “ACK” Pages

Similar to federal Form 9325, Acknowledgment and General Information for Taxpay-
ers who File Returns Electronically, generated with 1040 returns, the federal business 
packages generate an “EF Notice” page in View/Print mode for the main forms of fed-
eral returns and state business packages generate a “(ST)EF ACK” page for the main 
forms of state returns.

These are Drake Tax-generated forms that serve the same purpose as Form 9325: an 
acknowledgment that a return has been transmitted through Drake Tax and received 
by the IRS or the applicable state agency.

When a return is e-filed and you receive a “P” ack (indicating that the return is being 
processed) or an “R” ack (for a rejected return), the top section of the EF Notice is 
completed, noting the name and address of the client, the return type, the ERO who 
transmitted the return, and an indicator that the return was received by the IRS or 
applicable state agency.

When you download and process your acknowledgments and receive an “A” ack, the 
second section of the EF Notice is generated, indicating the return was accepted by the 
IRS or state agency and the date the return was accepted. The submission ID number 
is also included.

Additional Return Types

Short-year returns, 52–53-week year returns, and inactive returns can all be e-filed 
using Drake Tax. For information on how to indicate a short-year return in Drake Tax, 
see “Short-Year Returns” on page 14. Information on e-filing 52–53-week returns is 
provided in the following sections.

NOTES

An S corporation with $10 million or more in total assets that files 
250 or more returns a year is required to e-file its Form 1120S 
returns.

Every 1099, W-2, 940, and 941 form that is filed is counted as part 
of the 250-return threshold. For example, if a corporation filing an 
1120S return also files 150 W-2 forms, each W-2 would count as a 
separate return within the 250-return threshold.
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Electing a 52-53–Week Year (Initial Return)

To elect a 52-53–week year, a new entity (one that has never filed a return) must enter 
data on both screen 1 and the Year screen.

To elect a 52-53–week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year begins and 
Fiscal year ends dates. Use MMDDYYYY format, as shown in the example 
below.

2. Mark the 52-53-week tax year box.

In this example, the fiscal year begins 
09/28/2019 and ends 09/28/2020 (the last 
Friday in September), giving the entity a 
53-week year for 2020.

3. Click the Year link to open the Short Year Elections screen (Figure 21).

Figure 21: Elections for 52-53-week tax years

4. For line 1, select the month in which the 52-53–week year ends for the current fis-
cal year. (01 = January, 02 = February, etc.)

5. For line 2, select the day of the week the tax year always ends.

6. For line 3, enter the actual date that the tax year ends (the same date entered in the 
Fiscal year ends field on screen 1).

In subsequent years, only the 52-53–week tax year check box on screen 1 must be 
marked; the program automatically updates the dates.

Inactive Returns

Entities that are inactive but are still required to file returns may e-file inactive returns 
in Drake Tax. To indicate that a return is inactive:

NOTE
An entity that has filed returns in the past must complete only steps 1 
and 2 of this process. An entity that has never filed a return before must 
continue with steps 3 through 6.

NOTE
Once a 52-53–week year is selected, the corporation must use that 
accounting period every year. To change accounting periods, the corpo-
ration must submit to the IRS Form 3115, Application for Change in 
Accounting Method.
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1. Go to the PRNT screen, accessible from the General tab or Miscellaneous tab of 
the Data Entry Menu.

2. Under Items to Print, mark the Print inactive return check box.

When the return is calculated, the program displays the words “Inactive Return” on 
the main form of the return (specifically, in the box above line 1c). Zeros (“0”) are dis-
played where required by the IRS in order for amounts to be properly included in the 
e-file data.

For detailed instructions on e-filing returns in Drake Tax, see 2019 Drake Tax User’s 
Manual.

Common Reject Codes

If one or more of the following IRS reject codes is generated when e-filing an 1120S 
return, the preparer must contact the IRS for further information.The IRS
e-Help Desk telephone number is (866) 255-0654.

• Reject Code R0000-900-01 — The return type indicated in the return header 
must match the return type established with the IRS for this EIN. If you get this 
reject code, you must contact the IRS to correct its database or paper-file this 
return.

• Reject Code R0000-905-01 — Electronic Filing Identification Number (EFIN) in 
the return header must be listed in the e-file database and in “accepted status.” If 
you get this reject code, you must update your e-file application to include the 
1120S return type. This should be done at the IRS website. Review publication 
3112 for details.

• Reject Code F1120S-239-01 — Filer’s TIN and Name Control in the return 
header must match data in the e-file database unless Form 1120S, Item H (2), 
“Name Change” box is marked. Use the Entity Name Control Override field 
only if your client has obtained a Name Control from the IRS. See “Name Con-
trol,” following.

Name Control

(New for 2019) A Name Control field has been added to the EF screen. Use this 
Entity Name Control Override field only if your client has obtained a Name Control 
from the IRS.

NOTE All EF Messages must be cleared in order to e-file an inactive return.

NOTE
If a reject associated with the return’s “Name Control” occurs, some of 
your questions can be answered on the IRS’s website. For details, log 
in to the IRS website or go to irs.gov/businesses/corporations/using-
the-correct-name-control-in-e-filing-corporate-tax-returns See “Name 
Control,” following.
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A “Name Control” is established by the IRS when the entity requests an Employer 
Identification Number (EIN). The IRS creates the name control from the legal name 
listed on the Form SS-4, Application for Employer Identification Number.

Filers who cannot determine the correct Name Control must contact the Business Spe-
cialty Tax Line at (800) 829-4933 for assistance. The caller must qualify in one of the 
following three categories to receive assistance:

• Be designated as the Paid Preparer and the “Paid preparer” check box on the 
return is marked for the last filed return (The designation expires one year after 
the due date of the return in question. There are no exceptions or extensions to the 
expiration date)

• Have or provide Form 8821, Tax Information Authorization, authorizing the caller 
to discuss the corporation’s entity information

• Have or provide Form 2848, Power of Attorney and Declaration of Representa-
tive, authorizing the caller to discuss the corporation’s entity information

In general:

• The Name Control consists of up to four alphanumeric characters.

• The Name Control should be determined from the information specified on the 
first name line. Generally, the Name Control is derived from the first four charac-
ters of the entity name.

• An ampersand (&) or hyphen (-) are the only special characters allowed in the 
Name Control.

• The Name Control can have fewer, but no more than, four characters. Blanks may 
be present only at the end of the Name Control.

Do not include DBA or FBO as part of the Name Control.

Form 5471

Screens used to complete Form 5471, Information Return of U.S. Persons with 
Respect to Certain Foreign Corporations, are found on the Foreign tab of the Data 
Entry Menu. This form is used by certain U.S. citizens and residents who are officers, 
directors, or shareholders, or partners in certain foreign corporations.

Taxpayers who must file this form are described in the IRS instructions. Form 5471 
cannot be e-filed with the 1040 return. File by the due date (including extensions) for 
that return.

For details on using this form, see the IRS instructions for Form 5471.

GILTI Income 

Section 951A requires U.S. shareholders of controlled foreign corporations to deter-
mine and include their Global Intangible Low-Taxed Income (GILTI) in taxable 
income every year. Section 951A is effective for tax years of foreign corporations 
beginning after 2017, and tax years of U.S. shareholders in which or with which such 
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tax years of foreign corporations end. In Drake Tax, open screen I1, GILTI Informa-
tion, available on the Foreign tab of the Data Entry Menu.

For details on using this form, see the IRS instructions for Form 5471 or review the 
field helps on screen I1.

Specified Foreign Corporations and Form 965

Section 965 of the Code (section 965) was amended by section 14103 of the Tax Cuts 
and Jobs Act (TCJA) requiring certain taxpayers to include in income an amount 
based on the accumulated post-1986 deferred foreign income of certain foreign corpo-
rations of which they are U.S. shareholders, either directly or indirectly through other 
entities. This is reported on Form 965, Inclusion of Deferred Foreign Income Upon 
Transition to Participation Exemption System.

In Drake Tax, the SFC screen and screens used to complete Form 965 are in the Form 
965 and Schedules section of the Foreign tab of the Data Entry Menu.

e-FILE FinCEN Form 114

When you calculate a return in Drake Tax, any required information missing from 
screens 114 and FRGN generates EF Messages unique to the FinCEN Form 114 – 
listed in “FBAR Messages Pg” in View/Print mode. Before the FinCEN Form 114 can 
be made eligible for e-file, all FinCEN 114 EF Messages on the “FBAR Messages Pg” 
must be cleared (and FinCEN has a green check mark on the Calculation Results 
window if you have the Pause option selected at Setup > Options > Calculation & 
View/Print).

In data entry, open screen EF and mark the FinCEN 114 only check box. Click View 
(or press CTRL+V). “FinCEN114” is indicated on the EF Status page in View/Print 
mode and “Form 114” is displayed in the forms “tree” and is listed on the bill.

Close the return, and from the Home window toolbar, go to EF > Select Returns for 
EF. “FinCEN 114” is displayed in the EF Documents column of the EF Return 
Selector. EF. “FinCEN 114” will be displayed in the EF Documents column of the EF 
Return Selector.

Proceed as you would to e-file any other return in Drake Tax.

• Drake Tax produces “EF Notice - FBAR” as an acknowledgment that the e-filed 
FinCEN Form 114 report was received.

• No other returns—state or federal—can be transmitted with the FinCEN Form 114 
through Drake Tax.

• Form 114, Report of Foreign Bank and Financial Accounts (FBAR), can be 
e-filed through Drake Tax in the same way all returns are e-filed through Drake 
Tax (see 2019 Drake Tax User’s Manual. This report can also be completed on, 

NOTE
As of publication of this manual, the IRS had not released its final version 
of Forms 951A and 965; thus, the screens are inactive in Drake Tax.

These screens will be activated with an update when the IRS releases its 
forms at the release date of this manual.
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and submitted through, the BSA E-Filing System for the Financial Crimes 
Enforcement Network website at bsaefiling.fincen.treas.gov/main.html 

The link to the BSA website is available on screen 114 for those who prefer that 
method of filing or who are seeking more information on the BSA E-Filing System for 
the Financial Crimes Enforcement Network.

Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a document must be printed and 
scanned into the computer (or “saved” as a PDF document), and attached to the return 
in order to be e-filed with the return.

You can attach PDF files to federal S corporation 1120S returns for e-file. The PDF 
Attachments screen is accessible from the General tab of the Data Entry Menu.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake Tax:

1. Creating a PDF document to be attached

2. Informing the program that a PDF document will be sent with the return

3. Attaching the PDF document for e-file

These steps are described in the following sections.

Creating a 
PDF File

To create a PDF file:

1. Scan the document to be attached to the return.

2. Save the document to your client’s Drake Documents file, your computer’s desk-
top, or anywhere you can readily find it.

Adding PDF 
Documents 

To indicate in Drake Tax that a PDF document will be sent with the return:

1. Open the return in Drake Tax. From the General tab of the Data Entry Menu, 
click PDF Attachments or type PDF in the selector field and press ENTER 
(Figure 22 on page 72).

TIP It’s a good idea to use the Drake Documents scanning feature for this 
step.

NOTE
Many types of documents (for instance, documents created in Microsoft 
Word) can be printed or “saved” as PDF documents if you have a PDF 
printer (such as Adobe Reader) installed.
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Figure 22: Select PDF Attachments, or type PDF in the selector field and press ENTER.

2. Fill out the columns on the PDF Attachments screen. See Table 3 for examples.

3. Exit the PDF Attachments window.

Because you’ve indicated that a PDF file is attached, the program generates an EF 
Message regarding the attachment when the return is calculated.

Attaching 
Documents 

to the Return 

To attach a PDF file to a return:

1. From the toolbar, click View. If anything was entered in the PDF Attachments 
window (see “Adding PDF Documents” on page 71), there will be two PDF–
related items in the View/Print window:

• An EF “MESSAGES” alert (item #1 in Figure 23 on page 73)

• An “EF Attachments” document (blue squares in Figure 23 on page 73)

• An Attach PDF button on the toolbar (item #2 in Figure 23 on page 73)

Table 3: PDF Attachment Window Columns

Name of Column Description Examples

Reference Source
(This field is for your 
records only; it is not 
transmitted with the 
PDF.)

Name or number of regulation, 
publication, or form instruction that 
makes attachments necessary

- IRS Pub xxx-1.4
- Form Instructions for 1120S

Description Description of form or document to 
be attached

- Title of house on Oak Street
- Appraisal of Lot 1234

File name Distinctive, easily recognizable file 
name, followed by “.pdf”

- TitleHouseOakSt.pdf
- AppraisalLot1234.pdf
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Figure 23: The MESSAGES file (#1) and the Attach PDF button (#2)

2. Click the “EF PDF” file from the forms tree to see a listing all documents entered 
on the PDF screen.

3. Click the “MESSAGES” file in the forms “tree” to view EF Messages, including 
information on how to attach the required documents to the return.

4. Click the Attach PDF button. The EF PDF Attachments window displays the 
information entered on the PDF Attachments window in data entry (Figure 24). 
A red circle with an X means the document has not yet been attached; a green cir-
cle with a check mark indicates an attached document.

Figure 24: The EF PDF Attachments window 

5. Click the row of a document to attach.

6. Click Browse.

7. Find to the proper folder, select the PDF file to attach, and click Open (or double-
click the file name).
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Repeat for all documents with a red circle and X. When all documents have been 
attached to a completed return, recalculate to clear the EF Message. The return is now 
ready to be e-filed.

Printing Generated Documents

In some instances, Drake Tax generates a document that must be printed, signed, and 
scanned back into the computer to be attached to the return. For example, if Form 
2553, Election by a Small Business Corporation, is present in an S corporation return 
(and the Attaching Form 2553 as a PDF document check box is marked on screen 
1), EF Message 1513 is generated when the return is calculated, stating that attach-
ments are required. You must print and then complete the statements, scan them into 
the computer, save them as PDF documents, and attach them to the return.

Drake- 
Generated 

PDFs

Some required PDF attachments—such as Schedule B-1—are generated by the pro-
gram through data entry. These forms appear on the “EF PDF” page automatically and 
require no information be entered on the PDF screen. These attachments still must be 
“attached,” using the steps provided in “Attaching Documents to the Return” on 
page 72.

Importing Trial Balance Information

Drake Tax’s trial balance import feature allows data to be imported into an 1120S 
return from a trial balance worksheet. The trial balance template and importing func-
tion has the following benefits:

• Eliminates the need to duplicate entries

• Reduces data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

Preparing to Use Trial Balance Import

The trial balance import function can be used only on returns that were created in 
Drake Tax 2008 or later. Like several other functions of the tax program, this feature 
requires Microsoft Excel (version 2000 or later).

First, if you haven’t already, create a client file (open a new return) in Drake Tax 2019 
or update an existing client file from the prior year. Then create a trial balance work-
sheet. (See “Opening a Template” on page 76.)

Take the following steps to ensure the trial balance import works properly:

• Activate Macros — The trial balance import function uses macros in Microsoft 
Excel. Check your Excel settings to ensure that macros are activated and that 
macro settings are set to “Disable all macros with notification.” To do so, go to 

NOTE A flow chart of the trial balance importing process is available as an 
appendix at the end of this manual.
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File > Options in Excel and select the Trust Center tab. Click Macro Settings 
and select Disable all macros with notification, then click OK

• Disable Autobalance in Drake Tax — (optional) When autobalance is disabled, 
the program is prevented from automatically adjusting the year-end retained earn-
ings or capital amounts, thus allowing you to see any discrepancies in the balance 
sheet. To disable autobalance in Drake Tax, go to the PRNT screen and select 
Turn off autobalance (Figure 25).

Figure 25: Disable autobalance from the PRNT screen

• Force Schedule L — By default, Drake Tax does not display the balance sheet 
amounts on the return if the entity does not meet the filing requirement. If this is 
the case, you have to override the default setting in order to have the amounts 
shown on Schedule L. To force the Schedule L amounts to be printed, go to the
PRNT screen and select the Force-print Schedules L and M-1 box (Figure 26).

Figure 26: Force-print Schedule L box from the PRNT screen

• Check for Detail Worksheets — The trial balance import allows only those 
detail worksheets required by the IRS. Check updated returns for detail 
(CTRL+W) worksheets that are not required. For example, the IRS does not 
require a detail worksheet for the Gross receipts field on the INC screen; if a 
return has a detail worksheet for that field, the trial balance will not be imported 
correctly into the return. Detail worksheets are indicated by red shading, as shown 
in Figure 27 on page 76.

NOTE

In Excel 2007, click the Office button in the upper left and then click the 
Excel Options button at the bottom of the window. (In Excel 2013, click 
the File tab then select Options from the menu on the left.) Next, select 
Trust Center from the list at left, then click the Trust Center Settings 
button. Select Macro Settings from the list on the left, then choose 
Disable all macros with notification. Click OK and then OK.
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Figure 27: Example of an “unnecessary” detail worksheet

Delete (by pressing CTRL+D) unnecessary detail worksheets prior to import. See 
“Detail Worksheets” on page 78 for more information on using detail worksheets 
in the trial balance.

Preparing Financial Data for Import

To prepare the financial data for importing into the return, the data must be entered 
into Drake Tax’s specially designed trial balance template. Once this information is 
entered and saved, it can be imported into the return.

Opening a 
Template

The first step in preparing financial data for importing is to open a trial balance tem-
plate for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the Data Entry Menu.

2. Click Import > Trial Balance Import from the toolbar. The preliminary Trial 
Balance Import dialog box is opened.

3. Click Create New or Open Existing. If opening an existing file, click Open after 
selecting the correct file.

4. If a Security Warning box appears, click Enable Macros.

The trial balance template is displayed in Microsoft Excel.

File Location Whenever a new template is opened, the tax program assigns it a default file location 
and name. Trial balance templates are saved in the “TB” folder of your Drake19 pro-
gram. 

To change the name of a file in Excel, open the worksheet, select File > Save As, and 
assign the new name.

NOTE
In older versions of Excel, you may see a Security Warning message 
with an Options button. Click Options to open the Security Options 
dialog box, then select Enable this content. Click OK. (In Excel 2013, 
click Enable Content.)
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Template 
Structure

The trial balance template consists of three title rows and six columns. The Entity 
Name and Year End title rows can be edited; double-click a row to change the title. 
Columns are described in Table 4.

Displayed at the bottom of the trial balance worksheet are the calculated amount for 
Schedule M-1, line 1; the credit and debit totals; a cell showing whether or not the bal-
ance sheet is out of balance and, if applicable, the out-of-balance amount (see 
Figure 28; see also Figure 31 on page 79).

Figure 28: Schedule M-1 amount (1); totals (2); and indication of balance (3)

Following are instructions and guidelines for using the trial balance template to 
assemble financial data for importing into data entry.

NOTE If saving a trial balance to a different location, make a note of where 
you store it. The program automatically looks in the default directory.

Table 4: Trial Balance Template Columns

Column Description

Account Title Title of account

Debit/Credit Debit and credit amounts

Import to Screen and line in Drake Tax to which the debit or 
credit amount is imported

Reported on Location of the amount on the printed return

Other Information Additional details for preparers; see “Details for Pre-
parers” on page 81.
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Entering Financial Data

When a new trial balance file is opened for a return, all debit and credit amounts are 
zero ($0). All data must be entered manually into the template.

Direct Entry Most cells in the trial balance worksheet are view-only. In a new template, editable 
debit and credit cells are indicated by a dollar amount ($0) and are not gray.

Detail 
Worksheets

Some cells require more detail than can be entered on a single line. These cells are 
indicated by buttons (Figure 29). Buttons do not work if macros are disabled; see the 
Note in “Opening a Template” on page 76.

Figure 29: Example of cells that require worksheets 

Click a worksheet button to open a worksheet in a new tab. Figure 30 on page 79 
shows an example of the “Other Income” worksheet.

NOTE
Some data cannot be imported from the trial balance worksheet into the 
tax program and must be entered directly into the data entry fields 
within the program. For more on these categories of data, see “Special 
Conditions” on page 81.
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Figure 30: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the SBS TB tab (labeled “1” in Figure 30), 
or click the Click to return to TB button above the worksheet tabs (labeled “2” in 
Figure 30). Note that a detail tab (the “Other Income” tab in the lower left of 
Figure 30) might include one or more detail worksheets (labeled “3” in Figure 30).

Totals Totals are displayed at the bottom of each worksheet. If credit and debit columns are 
out of balance, the worksheet highlights the out-of-balance amount (Figure 31).

Figure 31: Out-of-balance amount is highlighted if columns are out of balance.

In addition to credit and debit totals, the main trial balance worksheet shows the net 
income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjust-
ments are made in the program.

NOTE
Do not create detail worksheets in data entry of the tax program if the 
trial balance worksheet does not provide an equivalent detail worksheet 
or the trial balance will not be imported correctly.
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Saving a File

To save a file, click the Save icon or select File > Save from the menu bar. (In older 
versions of Excel, click the Office button in the upper-left corner and select Save. In 
Excel 2013, click the File tab then Save.) To re-name a file when saving, select File > 
Save As. Trial balance templates are saved in the “TB” folder of your Drake19 pro-
gram.

Importing Data into a Return

Once a trial balance worksheet has been set up for a client in Drake Tax, the trial bal-
ance information can be imported into the program and calculated into the return.

To import a trial balance into a return:

1. Open the return into which you will import the trial balance information.

2. Click Import > Trial Balance Import from the menu toolbar. The preliminary 
Trial Balance Import dialog box is opened.

3. Click Next.

4. Enter or select the trial balance file to be imported. If necessary, click the button to 
the right of 1. Import File Name (blue circle in Figure 32 on page 81) to browse 
to the proper folder. By default, each trial balance file is an Excel (.xls) file show-
ing the client name and ending in “TB” for trial balance, as shown in the example 
in Figure 32 on page 81. (See “File Location” on page 76.)

NOTE The data cannot be imported if the worksheet is out of balance.

NOTES

Not all trial balance data can be imported directly into a return. For 
information on program limitations, see “Special Conditions” on 
page 81.

If you are already in the Trial Balance Import tool for the selected 
return, go to the Trial Balance Import window in Drake Tax and 
start at Step 3 of the following procedure.
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Figure 32: Selected file to import

5. Select any desired Trial Balance Additional Import Options. (See “Additional 
Import Options” following this procedure.)

6. Click Next and wait for the import to be completed.

7. Click Finish.

The program returns to the Data Entry Menu for the open return. Note that all 
selected data from the trial balance worksheet has been imported into the return. This 
can be seen both in the data entry screens and on the generated return.

Additional 
Import 

Options

The program can import the following additional information when importing the trial 
balance data. (Select the items to import or click Select All):

Special Conditions

Some items cannot be entered into the trial balance worksheet and must be typed 
directly into Drake Tax data entry. Other items should be entered into the worksheet 
for balance purposes but are not imported to data entry; these must be entered sepa-
rately and the calculated results compared to the trial balance worksheet.

Details for 
Preparers

Most trial balance items are imported directly to the location indicated in the program 
and on the return. For example, the amounts shown in Figure 33 on page 82 go to 
Schedule L, line 1, column d in the program and are shown on page 4, Schedule L, 
line 1, column d, of the 1120S return.

NOTE
If the program does not calculate the trial-balance information as 
expected, you can return to the trial balance worksheet, make adjust-
ments, and import the worksheet again.

Buildings & other depreciable assets Accumulated depreciation

Land Goodwill & other intangible assets

Accumulated amortization 8825/Rent information

Cost of goods sold depreciation
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Figure 33: Indication of where an amount will go in Drake Tax and on the return

The “Other Information” column in the trial balance worksheet indicates special con-
ditions and additional information regarding certain rows. Table 5 describes the most 
common notes in this column.

All “does not carry” notes are accompanied by further instructions in the “Import to” 
column to the left of the “Reported on” column, as shown in Figure 34.

SCH2 Detail Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is 
required for an item marked “does not carry” on the trial balance.

Figure 34: SCH2 screen in Drake Tax is required for “do not carry” items on trial balance

To complete an SCH2 detail screen in data entry:

Table 5: “Other Information” Column Notes

Note Description

not included in totals The amount is required for importing purposes only but is 
not included in the totals shown on the trial balance.

does not carry Information cannot be imported and must be entered on the 
appropriate screen in Drake Tax. Screen is specified in 
“Reported on” column.

optional Amount is optional; not required for import, but could require 
direct entry in Drake Tax data entry screens.

include deficit as negative 
number

Some deficits must be entered as negative numbers.

import includes the calculated 
change in inventory

Used for “total purchases”; when calculating cost of goods 
sold (COGS) in the return, the program takes the change in 
inventory into account for the Form 1125-A calculation.

[Form or Schedule] may be 
required

Non-financial information must be completed in Drake, in 
addition to the financial data entered in the worksheet.
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1. In Drake Tax, open the SCH2 screen in the return. The SCH2 screen is accessible 
from the General tab of the Data Entry Menu and through links on the L 
screen.)

2. On the SCH2 screen, select from the Line Number drop list.

3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of the Schedule L, press PAGE DOWN and repeat 
steps 2 and 3. Data is saved automatically upon entry.

When the return is produced, Schedule L of the return reflects both the amounts 
imported from the trial balance worksheet and the totals of the amounts entered on the 
SCH2 screen.

See “The SCH2 Screen” on page 52 for more details on using the SCH2 screen.

Depreciation S corporation returns can have up to four components of total depreciation:

• COGS 

• Real estate rental

• Rental other than real estate

• Any remaining depreciation

For trial balance purposes, enter depreciation amounts directly into the appropriate 
fields on the trial balance worksheet. Note that, for 1120S trial balances, rental 
expense detail worksheets are required for 8825 and RENT depreciation.

When the trial balance is imported, the COGS depreciation expense amount flows 
directly to the appropriate line of Form 1125-A of the return, and the rental deprecia-
tion expense amounts flow directly to the appropriate lines of the 8825 and RENT 
screens, as applicable. Because the remaining depreciation can comprise any number 
of assets, the amount entered on the trial balance does not flow to the return. To ensure 
that each component of the total remaining depreciation is calculated into the return, 
each asset must be entered on the applicable depreciation screens in data entry 
(Figure 35 on page 84).

NOTES

• Enter 8825 and RENT depreciation amounts in the detail work-
sheets for importing purposes, but be aware that the 8825 and 
RENT screens in the program must be edited if 4562 detail screens 
(see Figure 35 on page 84) are used.

• Accumulated depreciation is optional for the Trial Balance Import.

• Depreciation expense entered in the Trial Balance Import will over-
ride depreciation calculated by the tax program.
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Figure 35: Enter depreciable asset data on a 4562 detail screen, or enter the total depreciation 
on the override screens  6, 7, 8, and 9). 

Rental 
Expenses

The following information applies only to S corporations with multiple rental proper-
ties.

The S corporation trial balances include lines for rental income and expenses 
(Figure 36). Both rental expense items require a trial balance detail worksheet.

Figure 36: Rental expense rows on an S corporation trial balance worksheet

When imported, the rental expense data entered on the trial balance worksheet appears 
on either an 8825 screen (if real estate rental) or the RENT screen (if rental other than 
real estate).

Because the trial balance worksheet has only one detail screen per rental type, the 
importing function does not accommodate entities with multiple rental properties or 
expenses; however, the following procedure allows the trial balance to remain in bal-
ance if there are multiple rental properties or expenses.

To accommodate entities with multiple rental properties or expenses:

1. Calculate the totals for both types of rental expenses.

NOTE

Entering the remainder of the depreciation on the trial balance 
worksheet helps ensure that the balance sheet balances and pro-
vides a way to check that the amount on line 1 of Schedule M-1 is 
correct. Compare the calculated line 1 at the bottom of the trial bal-
ance to the equivalent line on Schedule M-1 of the calculated 
return. If the depreciation amounts match but the line 1 amounts 
differ, an M-1 adjustment could be required.
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2. Enter the income totals on the trial balance sheet and the expense totals on the 
applicable detail sheets (Figure 36 on page 84).

3. Ensure that the balance sheet is in balance.

4. Import the trial balance worksheet into the return. The applicable screens in data 
entry now contain the figures entered on the trial balance worksheet.

5. Enter the amounts on additional screens that require details. (For more informa-
tion on data that cannot be imported, see “Special Conditions” on page 81.)

6. Compare the M-1, line 1 amount on the trial balance to the M-1, line 1 amount on 
the calculated return to ensure that they match.

7. Complete all 8825 or RENT screens in data entry, as applicable, for the individual 
rental properties or items.

8. Delete the 8825 and RENT screens that were imported from the trial balance (the 
screens reflecting the total rental expenses).

Other Program Imports

Information for other outside worksheets can be imported into your 1120S return.

Form 4562 
Import

With the 4562 Import function, you can import depreciable assets into Drake Tax 
from Excel worksheets (Excel 97-2003 and Excel 2007/2010 or later), from a TAB 
(tab delimited) file, or a .CSV (comma separated value) file. After the import is com-
pleted, each asset or transaction appears on a separate 4562 screen.

To successfully import depreciable assets from a worksheet into Drake Tax, the work-
sheet must be correctly formatted. The best and quickest way to get a properly format-
ted Excel worksheet is to download a template from Drake Software. To do so:

1. Open a client’s tax return.

2. From the Data Entry Menu toolbar, click Import > Form 4562 Import.

3. Click the Form 4562 Import information and sample spreadsheet link to open 
Drake Software Knowledge Base article 15982 on downloading the worksheet 
template. (Also in that article is a 4562 Import link to an instructional video.)

4. In the 15982 article, scroll down to “2018 - 1120S Import Template.” Click to 
download the template.

The worksheet is downloaded to your computer. Open it and save it where you can 
easily find it, such as the client’s file in Drake Tax, in Drake Documents, or on your 
desktop.

To use the 4562 Import feature:

NOTE
If the amounts do not match, review the imported amounts to ensure 
that all data was imported. If the data appears to have imported cor-
rectly, an M-1 adjustment could be necessary.

NOTE
To delete a screen in data entry, open the screen and press CTRL+D. If 
a multiple forms list appears, ensure that the screen to delete is 
selected, then click Delete.
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1. Open a client’s tax return.

2. From the Data Entry Menu toolbar, click Import > Form 4562 Import.

3. When you are ready to begin the import process, click Next.

4. When the Form 4562 Import - Step 1 window is opened, click Browse, find your 
worksheet, click Open, then click Next.

5. When the Form 4562 Import - Step 2 window is opened, select the row where 
you wish to begin the import. (If the first row in the asset list is column headers, 
begin the import with row 2.) Click Next.

6. Click Import.

If you use an Excel worksheet from other sources, you can still import the asset infor-
mation into Drake Tax, but you need to aware of certain parameters. For the asset 
information to be imported correctly:

• In an Excel workbook, the import data must be on the first sheet in the workbook.

– View the workbook and check the tabs across the bottom of the window. If 
there is more than one tab, click and drag the worksheet you want to use to the 
left until it is the first tab.

– The name on the tab does not matter.

• The import file must contain the specified columns in the specified order. Each 
column represents a field on the 4562 screen as determined by the column loca-
tion (not by the header labels, which are optional)

• Except for column headers, do not put anything in the import file that should not 
be imported.

• If you include column headers, make sure to start importing on the first data row, 
not the header row. (Start import at row 2.)

• If totals are present, remove them. The totals may be imported, doubling your 
data.

• The best way to enter dates in Excel is to format the date columns as text in 
MMDDYYYY format (separators can be used or omitted).

Form 8949 
Import

With the Form 8949 Import/GruntWorx Trades feature, you can import capital gain 
and loss transaction data into Drake Tax from Excel worksheets (Excel 97-2003 and 

NOTE If a column in the template is red, that column will not be imported into 
the return. 

TIP

Whether using the downloaded worksheet for the 4562 import or the 
8949 import (see “Form 8949 Import,” following), or building your own, 
you can import the data more than once. When you are sure the correct 
data is imported, you can delete previous import attempts by opening 
the corresponding 4562 screens (or 8949 screens) and pressing 
CTRL+D. 

For more help, see “Form 4562 Import” and “Form 8949 Imports” in 
Chapter 5 of the 2019 Drake Tax User’s Manual.
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Excel 2007/2010 or later), from a TAB (tab delimited) file, or a .CSV (comma sepa-
rated value) file.

To successfully import transaction information from a worksheet into Drake Tax, the 
worksheet must be correctly formatted. (GruntWorx Trades are already properly for-
matted.) The best and quickest way to get a properly formatted Excel worksheet is to 
download a template from Drake Software. To do so:

1. From the Home window toolbar in Drake Tax, click Support > Drake Software 
Knowledge Base.

2. When the Drake Software Knowledge Base is opened, in the Quick Search field 
in the top-right corner of the window, type 10139 and click the magnifying glass 
icon on the right.

3. After the search has been completed, click “10139: Schedule D Form 8949 Grunt-
worx Trades Import” from the Search Results.

4. In article 10139, scroll down to Attachments and click “2016 and Future…”

The worksheet is downloaded to your computer. Open it and save it where you can 
easily find it, such as the client’s file in Drake Tax, in Drake Documents, or on your 
desktop.

To use the 8949 Import feature:

1. Open a client’s tax return.

2. From the Data Entry Menu toolbar, click Import > Form 8949 Import.

3. In the Form 8949 Import window, review the example spreadsheet format.

4. When you are ready to begin the import process, click Next.

5. When the Form 8949 Import - Step 1 window is opened, click Browse, find your 
worksheet, click Open, then click Next.

IMPORTANT

• When importing 8949 data into an 1120S return from 
the Drake Tax template, the “TSJ” column in the work-
sheet represents the Property Type field on screen 
8949.

• Be aware that data in certain cells of the Drake Tax tem-
plate are not imported to screen 8949. For instance, the 
“AMT” cells and the “QSBS” cells in the template have 
no corresponding fields on screen 8949; when 8949 
data is imported, anything in those columns is ignored.

• If you are building your own worksheet, however, the 
“AMT” and the “QSBS” columns must be included in the 
worksheet but enter no amounts should be entered; 
when 8949 data is imported, those two columns are 
ignored. For best results, include all columns displayed 
in the “Example Spreadsheet” in Step 3, below.

• Do not include the “EIN (QOF Only)” column when 
building your worksheet.
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6. When the Form 4562 Import - Step 2 window is opened, select the row where 
you wish to begin the import. (If the first row in the asset list is column headers, 
begin the import with row 2.) Click Next.

7. When the Form 4562 Import - Step 3 window is opened. Click Import.

After import, each transaction appears on a separate 8949 screen.

Form 3115, Application for Change in Accounting Method 

Form 3115, Application for Change in Accounting Method, is an application to the 
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any item.

Form 3115, Application for Change in Accounting Method, is eligible for e-file.

Drake Tax customers can complete and e-file Forms 3115 and related schedules and 
attachments for corporation returns.

Accessing Screens for Changing Accounting Method

Several screens may be required for completing Form 3115. These screens are accessi-
ble from the Change in Accounting Method box, located under the Other Forms tab 
of the Data Entry Menu. These screens include:

• Screen 3115 (Change in Accounting Method) — Used to access fields for Form 
3115, including Schedules A through D

• Screen 311E (Schedule E) — Used to request a change in depreciation or amorti-
zation methods

• Screen ATT (Explanations and Attachments) — Used to create and view cer-
tain attachments to be generated by the program

• Screen ATT2 (Pt II Ln 14 & Pt III Ln 24b Attachment) — Used to complete 
certain parts of Form 3115 that require specific attachments

When you open screen 3115, the program displays the first of six screen tabs. As 
shown in Figure 37 on page 89, you can access the various 3115 screens by clicking a 
tabbed link at the top of any of the 3115 screens.

NOTES
• Click the 8949 Import Tool link in KB article 10139 to view an 

instructional video using the 8949 Import feature.

• For more help, click Help from the Form 8949 Import window (in 
Step 3 on page 87) or see “Form 4562 Import” and “Form 8949 
Imports” in Chapter 5 of the 2019 Drake Tax User’s Manual .

NOTES

In some cases, Form 3115 must still be paper-filed. See IRS 
instructions for details.

Applicants filing Form 3115 should refer to Rev Proc. 2015-13 for 
general automatic change procedures, and to Rev Proc. 2015-14 
for a list of automatic changes to which the automatic change pro-
cedures in Rev. Proc. 2015-13 apply.
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Figure 37: Tab links on 3115 screen

Multi-form 
Codes

All 3115 and related screens contain a Multi-form code text box (shown in Figure 37) 
that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-
cation you create in Drake Tax. The first should be “1,” the second “2,” and so on. 
When using other screens, such as the 311E or ATT screens, you can use those num-
bers to indicate which instance of Form 3115 the 311E or ATT screen should be asso-
ciated with.

Notices of 
Missing 

Attachments

In addition to Form 3115 and related schedules and statements, the program produces 
EF Messages (as applicable) when the return is calculated. All forms, schedules, EF 
messages, and worksheets are accessible from View/Print mode.

EF Messages for Form 3115 provide information about required attachments (includ-
ing PDF attachments) that are missing from the return. Some EF Messages list all 
statements required for a particular section but do not indicate which statements, spe-
cifically, are missing. To best understand which attachments are still required, com-
pare the ATT screen and the EF PDF worksheet to the list on the EF Message.

NOTE If only one Form 3115 is being submitted, it is not necessary to enter 
anything in the Multi-form code box.

TIP
See Screen Help (accessible from the 3115 screen toolbar, from the 
right-click menu, or by pressing CTRL+ATL+?) to access the Form 3115 
instructions through the IRS website.

NOTES

• All EF Messages must be eliminated before the return is eligible for 
e-file. EF Messages for Form 3115 attachments are eliminated when 
all required statements have been attached to the return.

• In View/Print mode, various Return Notes appear on the NOTES 
page. These Return Notes provide information or reminders about 
the return but do not prevent e-file. They are informational only.

• To keep a specific Return Note from being generated whenever you 
view this return, open the HIDE screen (available from the Miscella-
neous tab of the Data Entry Menu or by typing HIDE into the selec-
tor field and pressing ENTER), type the number of the note to hide 
into one of the boxes, and then recalculate the return.
Tax Year 2019 89



Form 3115, Application for Change in Accounting Method Drake Tax Manual Supplement: S Corporation
This page intentionally left blank.
90 Tax Year 2019



Drake Tax Manual Supplement: S Corporations
Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a corporation tax return from a trial 
balance worksheet.

Drake Tax’s specially designed trial balance template and importing function has the following 
benefits:

• Eliminates the need to duplicate entries

• Eliminates data entry errors by automatically importing data to the correct fields

• Allows preparers to merge basic accounting functions with tax preparation

See next page for a flow chart describing the use of the trial balance import.
Tax Year 2019 A-1



Trial Balance Import: General Process
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Index

Numerics
52-53-week year returns 67

A
accounting method

changing 88–90
entering 15

accumulated adjustments account (Schedule M-2) 57
address

change of 15
e-mail 31
entering on Form 1120S 13
foreign 46
out-of-state 12

adjusted basis worksheet 50, 65
adjustments

credit 18
depreciation 55
section 481 17
to income and expenses 62

advertising expenses 22
Aggregation

multiple 41
aggregation 39
amended

1120S returns 15, 29
K-1 letters 50

amortization 23, 52
analysis of accounts (Schedule M-2) 56–59
APPT screen, see Multi-State apportionment
asterisks (on K-1 codes) 46
attachments

binary (PDF) 71–74
Form 8825 statements 62
to Form 3115 88

autobalance 54

B
bad debts 17, 20
basis 50–51

see also adjusted basis worksheet
binary (PDF) attachments 12, 71
books

in care of 19
book-to-tax differences (Schedule M-1) 54, 55
Business Activities Statement 42

business activity codes 15
Business Aggregation Number 39

PBAN 39

C
calendar-year returns 14
change file type 12
Change in Accounting Method 88–90
change of name or address 15
charitable contributions 35
Client Communications Editor (for letters) 50
codes

business activity 15
K-1 46, 65
miscellaneous (screen 1) 12
multi-form 60, 89
state 31

compensation of officers 19
compensation of shareholders 18
contact information (for state returns) 31
control number 44
cost of goods sold, see  Schedule A (Cost of Goods Sold)
cover letters (K-1) 49
coversheets 65
credit adjustments 18
credits 62
Ctrl+W (detail) worksheets 16, 17, 75

D
data entry

for state information 31
importing trial balance into 74–85

dates
of incorporation 15
payment (changing) 26
tax year 13

decrease to basis 51
deductions 18–23

QBI 15, 35
depletion 22

oil and gas 41
depreciation 17

and auto-balance errors 54
expense 21
for cost of goods sold (Schedule A) 16
of rentals 59
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on short-year returns 14
printing Form 4562 64
trial balance (business returns only) 83

detail (Ctrl+W) worksheets 16, 17, 75
direct debit of balance due 26–27
direct deposit of refunds 25
distributions 57
Doing Business As 13
domestic production activities deduction 48
due dates 26

E
EF_ACK page 66
e-filing

Form 1120S 66
PDF attachments 71–74
statements 53

Elections
Safe Harbor 64

elections 62
statements 64

electronic
funds withdrawal 26–27
signatures (PIN) 28

Employee benefits programs 22
employer identification number (EIN) 15
envelope coversheets 65
error codes 68
estimates

previous-year tax 24
underpayment of 25

expenses 18–23
exporting K-1 data 47
extensions 27

F
filing instructions 65
final return 15
first year returns 14
fiscal year returns 14
foreign

addresses for shareholders 46
transactions 26

Foreign Transaction Statement 34
Form 1125E 64
Form 2553 (Election by a Small Business Corporation) 11, 

15
Form 3115 (Application for Change in Accounting 

Method) 88–??
Form 4136 (Credit for Federal Tax Paid on Fuels) 24
Form 4562 (Depreciation and Amortization) 59, 64
Form 4797 (Sales of Business Property) 17

Form 5884 (Work Opportunity Credit) 17
Form 6765 (Credit for Increasing Research Activities) 17
Form 7004 (Application for Automatic Extension of Time 

to File) 27
Form 8050 (Direct Deposit of Corporate Tax Refund) 25
Form 8820 (Orphan Drug Credit) 17
Form 8825 (Rental Real Estate Income and Expenses of a 

Partnership or an S Corporation) 59–62
Form 8844 (Empowerment Zone Employment Credit) 17
Form 8845 (Indian Employment Credit) 17
Form 8846 (Credit for Employer Social Security and Medi-

care Taxes Paid on Certain Employee Tips) 17, 20
Form 8873 (Extraterritorial Income Exclusion) 23
Form 8881 (Credit for Small Employer Pension Plan Start-

up Costs) 17
Form 8903 (Domestic Production Activities 

Deduction) 48
Form 8912 (Credit to Holders of Tax Credit Bonds) 17
Form 8916-A (Supplemental Attachment to Schedule M-

3) 55
Form 8941 (Credit for Small Employer Health Insurance 

Premiums) 17
Form 8941 (Credit for Small Employer Health-Insurance 

Premiums) 23
Form 8990, Limitation on Business Interest Expense Under 

Section 163(j) 30
Form 8996, Qualified Opportunity Fund 30
Form 8997, Initial and Annual Statement of Qualified Op-

portunity Fund Investments 30
Form 965, Inclusion of Deferred Foreign Income Upon 

Transition to Participation Exemption System 70
Form T (Forest Activities Schedules) 22

G
gains and losses 17
GILTI 69
Global Intangible Low-Taxed Income 69
gross receipts 16

H
header information 13

I
import

4562 85
8949 86

import, trial balance 74–85
In care of 13
inactive returns 64, 67
income 16–18
increase to basis 51
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instructions for filing 65
insurance proceeds, income from 17
interest

expense 21
income 17

inventory 16

K
K-1

codes 46
export 47
overrides 45
Schedule for 1120S 42–51

L
labor 18
letters (K-1) 49

M
maintenance costs 20
Multi-State Apportionment 31

N
name and address

corporation 13
shareholder 43

name change 15
name control 68
name control reject 68
net operating losses (NOL) 58
next-year depreciation listing 64
number of shareholders 15

O
officer compensation 19
oil and gas depletion 41
ordinary gains and losses 17
other

adjustments account 59
costs (Schedule A) 16
deductions 23
expenses 60
income (loss) 17

ownership
changes 45
percentages 19

Ownership and participation 19

P
passive income 23
PBAN 39
PDF (binary) attachments 12, 71–74
pension and prior sharing 22
percentage, stock and ownership 19
PIN (electronic) signatures 28
printing

cover letter for K-1 49
K-1 items 46
line 22a worksheet 23
statements for Schedule L 53
suppressing/forcing documents 64

Q
QBI

aggregations 40
deduction 35
real activities 61
Statement A 36
Statement B 36
Statement C 36
statements and worksheets 36

Qualified Business Income 15, 35
Qualified Opportunity Funds 30

R
real estate 83
receipts 16
reconciliation

Schedule L and M-2 51
Schedules M-1, M-3 54

references to forms and worksheets 65
refunds

direct deposit of 25
state tax 17

rent paid on business property 20
rental activities 59–62
rental properties

safe harbor 38
repair costs 20
retained earnings reconciliation (worksheet) 65
returns

52-53-week year 67
amended 29
bankruptcy 66
extensions for 24, 27
fiscal and calendar year 13
inactive 67
short-year 14
signing 28
tax-exempt organizations (990) 71–74
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updating prior-year 11
revocation of S election 15
rounding shareholder 43

S
S corporation

changing to 12
electing as 11
termination of 15

Safe Harbor 38, 64
elections 64

safe harbor
rental activities 38

scanning (PDFs for e-filing) 71
SCH2 screen (for Schedule L) 52
Schedule B (Other Information) 29
Schedule D (Capital Gains and Losses and Built-In Gains)

Parts I, III, and III 23
Schedule K (Shareholders’ Pro Rata Share Items) 33–35
Schedule K-1

supplemental information 48
Schedule K-1 (Share of Income, Deductions, Credits, etc.)

sorting business K-1s 44
viewing business K-1s 44

Schedule K-1 (Shareholder Information) 42–51
Schedule L 64
Schedule L (Balance Sheet per Books) 51–54
Schedule M-1 54, 64
Schedule M-2 56–59
Schedule M-3 56
section

481 adjustments 17
Section 199A items 37
security

business packages 65
security screen 65
Service trade or business 36
shareholders

adjusted basis worksheet 50–51
compensation of 18
foreign addresses for 46
multiple 46
number of 15
rounding 43
Schedule K-1 42
updating data annually 51

short-year return 14
short-year returns 14
signatures, electronic 28
signs return 19, 43
SSTB 36
state

address 12

codes 31
-specific information 31
tax refunds 17, 25

statements
elections 64

T
tax

and payments 23–25
on fuels, credit for 17
returns, see returns
years (fiscal vs calendar) 13

taxes and licenses 20
termination of S election 15
trial balance import

and depreciation 17
and Schedule L 51, 53
instructions for using 74–85

U
underpayment of estimated tax 25
undistributed taxable income previously taxed 58
updating

an 1120S return 11
shareholder data annually 51

V
vouchers 24

W
wages 18

Y
Year screen 14
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